Notices

© Agilent Technologies, Inc. 2006

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

Manual Part Number
N9320-90001

Edition
Printed in China

Agilent Technologies, Inc.
Hi-Tech Industrial Development Zone (West District)
Chengdu 611731, P.R.C

Software Revision
This guide is valid for A.01.00 revisions of the Agilent N9320A Spectrum Analyzer software.

Warranty
The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend
U.S. Government Restricted Rights. Software and technical data rights granted to the federal government include only those rights customarily provided to end user customers. Agilent provides this customary commercial license in Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212 (Computer Software) and, for the Department of Defense, DFARS 252.227-7015 (Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial Computer Software or Computer Software Documentation).

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING
A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
In This User’s Guide...

This guide contains operation information for the N9320A Spectrum Analyzer.

1 Overview
A quick overview of the front and rear panels.

2 Getting Started
Unpacking and setting up your analyzer.

3 Functions and Measurements
How to use the analyzer in the basic applications.

4 Key Reference
Describe every front-panel hardkeys and the related softkeys’ functions in detail.

5 One-Button Measurements
Describe the key definition of one-button measurement.

6 Instrument Messages
This chapter give the instrument messages of the analyzer.

7 In Case of Difficulty
This chapter provides some information and tips when you met some difficulties.

8 Menu Maps
The overall list of the menu structure maps.

For more information about N9320A Spectrum Analyzer, see www.agilent.com/find/n9320a.
Contents

1 Overview 1
   Agilent N9320A at a Glance 2
   Front Panel Overview 3
      Display Annotations 6
   Rear Panel Overview 8
   Front and rear panel symbols 9

2 Getting Started 11
   Check the Shipment and Order List 12
   Power Requirements 13
   Safety Notice 15
   Electrostatic Discharge Protection 16
   Environmental Requirements 17
   Power on and Check 18
   Some helpful Tips 20
      Running Internal Alignments 20
      Enable the Options 20
      Using an External Reference 21
      Firmware Revision 21
   Remote Control 22

3 Functions and Measurements 23
   Making a Basic Measurement 24
   Measuring Multiple Signals 28
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comparing Signals on the Same Screen</td>
<td>28</td>
</tr>
<tr>
<td>Using Marker Delta</td>
<td></td>
</tr>
<tr>
<td>Comparing Signals not on the Same Screen</td>
<td>30</td>
</tr>
<tr>
<td>Using Marker Delta</td>
<td></td>
</tr>
<tr>
<td>Resolving Signals of Equal Amplitude</td>
<td>32</td>
</tr>
<tr>
<td>Resolving Small Signals Hidden by Large Signals</td>
<td>35</td>
</tr>
<tr>
<td>Measuring a Low-Level Signal</td>
<td>37</td>
</tr>
<tr>
<td>Reducing Input Attenuation</td>
<td>37</td>
</tr>
<tr>
<td>Decreasing the Resolution Bandwidth</td>
<td>39</td>
</tr>
<tr>
<td>Trace Averaging</td>
<td>40</td>
</tr>
<tr>
<td>Improving Frequency Resolution and Accuracy</td>
<td>41</td>
</tr>
<tr>
<td>Tracking Drifting Signals</td>
<td>43</td>
</tr>
<tr>
<td>Measuring a Source’s Frequency Drift</td>
<td>43</td>
</tr>
<tr>
<td>Making Distortion Measurements</td>
<td>45</td>
</tr>
<tr>
<td>Identifying Analyzer Generated Distortion</td>
<td>45</td>
</tr>
<tr>
<td>Third-Order Intermodulation Distortion</td>
<td>48</td>
</tr>
<tr>
<td>Measuring Phase Noise</td>
<td>51</td>
</tr>
<tr>
<td>Viewing Catalogs and Saving Files</td>
<td>52</td>
</tr>
</tbody>
</table>

4 Key Reference 57

<table>
<thead>
<tr>
<th>Key Reference</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplitude</td>
<td>58</td>
</tr>
<tr>
<td>Auto Tune</td>
<td>60</td>
</tr>
<tr>
<td>Back &lt;-</td>
<td>61</td>
</tr>
<tr>
<td>BW/Avg</td>
<td>62</td>
</tr>
<tr>
<td>Det/Display</td>
<td>65</td>
</tr>
<tr>
<td>Enter</td>
<td>71</td>
</tr>
<tr>
<td>File</td>
<td>72</td>
</tr>
<tr>
<td>Frequency</td>
<td>78</td>
</tr>
</tbody>
</table>
1
Overview

Agilent N9320A at a Glance  2
Front Panel Overview  4
Rear Panel Overview  9
Front and rear panel symbols  10

This chapter describes the general features and functions of the Agilent N9320A spectrum analyzer and provides an introduction of the front and rear panels.
Agilent N9320A at a Glance

An Agilent N9320A spectrum analyzer is a swept portable spectrum analyzer with a frequency range of 9 kHz to 3.0 GHz. It can be a fundamental component of an automated system, and be widely used in electronic manufacturing functional/final/QA test systems.

An Agilent N9320A spectrum analyzer provides features and functions as below:

- **High sensitive measurement**
  The spectrum analyzer includes a pre-amplifier for signal up to 3 GHz, enabling highly sensitive measurements. This helps in analysis of weak signals.

- **Pass/fail limits**
  Upper and lower limits can be set on the screen, thereby enable the user to make PASS/FAIL judgments on trace data.

- **Four-trace detection display**
  The spectrum analyzer displays up to four independent traces simultaneously.

- **SSB Phase Noise Measurement**
  The analyzer provides the automatic single-sideband phase noise measurement capability (dBc/Hz). The display includes frequency offset and the noise value.

- **Frequency counter with 0.1 Hz resolution**
  The built-in counter allows the user to measure the signal frequency with 0.1 Hz resolution.

- **USB interface**
  Using this interface allows the operator to save and transfer a screen shot (in JPG format) to a USB storage device. This feature enables measurement data to be gathered and pasted into reports in a PC environment.
Front Panel Overview

This section provides the information of the front panel.

1 **Screen** shows information of the current function, including the signal traces, status indicators, and instrument messages. Labels for softkeys are located on the right-hand side of the screen.

2 **Softkeys** are the unlabeled keys next to the screen. They activate functions displayed to the left of each key.

3 **Amplitude** activates the reference level function and accesses the amplitude softkeys, with which you set functions that affect data on the vertical axis.

4 **SPAN** sets the frequency range symmetrically about the center frequency. The frequency-span readout describes the total displayed frequency range.

5 **Frequency** activates the center-frequency function, and accesses the menu of frequency functions.

6 **Function keys** relate directly to the following main functions:
• **Preset/System (Local)** accesses the softkeys to reset the analyzer to a known state, if the analyzer is in the remote mode, pressing this key returns the analyzer to the local mode and enables front-panel control.

• **Auto Tune** search the signal automatically and locate the signal to the center of the graticule. see “Auto Tune” on page 60.

• **BW/Avg** activates the resolution bandwidth function and accesses the softkeys that control the bandwidth functions and averaging.

• **Sweep/Trig** accesses the softkeys that allow you to set the sweep time, select the sweep mode and trigger mode of the analyzer.

• **View/Trace** accesses the softkeys that allow you to store and manipulate trace information.

• **Det/Display** accesses the softkeys that allow you to configure detector functions and control what is displayed on the analyzer, including the display line as well as the testing of trace data against entered limits.

• **MODE** selects the measurement mode of your analyzer.

• **Meas** accesses the softkeys that let you make transmitter power measurements such as adjacent channel power, occupied bandwidth, and harmonic distortion, etc. Please refer to “One-Button Measurements” on page 101.

• **Marker** accesses the marker control keys that select the type and number of markers and turns them on and off.

• **Marker->** accesses the marker function softkeys that help you with the measurement.

• **Peak Search** places a marker on the highest peak.

• **File/Print** accesses the softkeys that allow you to configure the file and printing system of the analyzer.

7 **Data Control Keys** including the arrow keys, back key, Enter key, knob, and numeric keypad, change the numeric value of an active function such as center frequency, start frequency, resolution bandwidth, and marker position.
8 **RF IN connector** is the signal input for the analyzer. The maximum damage level is average continuous power +40 dBm, DC voltage 50 VDC. The impedance is 50 Ω (N-type female).

9 **PROBE POWER connector** provides power for high-impedance AC probes or other accessories (+15 V, –12 V, 150 mA maximum).

10 **CAL OUT connector** provides an amplitude reference signal output of 50 MHz at –10 dBm (BNC female).

11 **TG SOURCE connector** N-type female, is the source output for the built-in tracking generator. The impedance is 50 Ω (for Option TG3)

If the tracking generator output power is higher than the maximum power that the device under test can tolerate, it may damage the device under test. Do not exceed the maximum power of DUT.

12 **Standby Switch** switches on all functions of the analyzer. To switch the analyzer off, press the switch for at least 2 seconds. This deactivates all the functions but retains power to internal circuits so long as the analyzer is connected to line power.

13 **On LED** (green) lights when the analyzer is switched on.

14 **Standby LED** (orange) lights when the analyzer is connected to the line power.

15 **Remote LED** (red) lights when the analyzer is remotely controlled by a PC via the USB host interface on the rear panel.

16 **USB connector (DEV)** provides a connection between external USB devices and the analyzer, such as a USB memory device.
### Display Annotations

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Notes (Associated function key)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Amplitude scale</td>
<td>[Amplitude] &gt; Scale Type</td>
</tr>
<tr>
<td>2</td>
<td>Detector mode</td>
<td>[Det/Display] &gt; Detector</td>
</tr>
<tr>
<td>3</td>
<td>Reference level</td>
<td>[Amplitude] &gt; Rel Level</td>
</tr>
<tr>
<td>4</td>
<td>Active function block</td>
<td>The function in use</td>
</tr>
<tr>
<td>5</td>
<td>Time and date display</td>
<td>[Preset/System] &gt; Time/Date</td>
</tr>
<tr>
<td>6</td>
<td>RF attenuation</td>
<td>[Amplitude] &gt; Attenuation</td>
</tr>
<tr>
<td>7</td>
<td>Marker frequency</td>
<td>[Marker] or [Marker] &gt; Function &gt; Frequency Counter</td>
</tr>
<tr>
<td>8</td>
<td>Uncal indicator</td>
<td>The readout of amplitude is uncalibrated.</td>
</tr>
<tr>
<td>9</td>
<td>Marker amplitude</td>
<td>[Marker]</td>
</tr>
<tr>
<td>10</td>
<td>External reference</td>
<td>An external frequency reference is in use.</td>
</tr>
<tr>
<td>11</td>
<td>Remote mode</td>
<td>The analyzer is in remote mode</td>
</tr>
<tr>
<td>12</td>
<td>Key menu title</td>
<td>Dependent on key selection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>13</td>
<td>Softkey menu</td>
<td>Refer to “Key Reference” for details.</td>
</tr>
<tr>
<td>14</td>
<td>Frequency span</td>
<td>[SPAN]</td>
</tr>
<tr>
<td>15</td>
<td>Sweep time</td>
<td>[Sweep/Trig] &gt; Sweep Time</td>
</tr>
<tr>
<td>16</td>
<td>Video bandwidth</td>
<td>[Bw/Avg] &gt; Video BW</td>
</tr>
<tr>
<td>17</td>
<td>Display status line</td>
<td>Display status and instrument messages.</td>
</tr>
<tr>
<td>18</td>
<td>Resolution bandwidth</td>
<td>[Bw/Avg] &gt; Res BW</td>
</tr>
<tr>
<td>19</td>
<td>Center frequency</td>
<td>[Frequency] &gt; Center frequency</td>
</tr>
<tr>
<td>20</td>
<td>Continuous peak</td>
<td>[Peak Search] &gt; Continuous pk</td>
</tr>
<tr>
<td>21</td>
<td>Signal track</td>
<td>[Frequency] &gt; Signal Track</td>
</tr>
<tr>
<td>22</td>
<td>Internal preamplifier</td>
<td>[Amplitude] &gt; Int Preamp</td>
</tr>
<tr>
<td>23</td>
<td>Trigger/Sweep</td>
<td>[Sweep/Trig]</td>
</tr>
<tr>
<td></td>
<td>F - free run trigger</td>
<td></td>
</tr>
<tr>
<td></td>
<td>V - video trigger</td>
<td></td>
</tr>
<tr>
<td></td>
<td>E - external trigger</td>
<td></td>
</tr>
<tr>
<td></td>
<td>C - continuous sweep</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S - single sweep</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Trace mode</td>
<td>[Trace]</td>
</tr>
<tr>
<td></td>
<td>W - clear write</td>
<td></td>
</tr>
<tr>
<td></td>
<td>M - maximum hold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>m - minimum hold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>V - view</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S - store blank</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Average</td>
<td>[Bw/Avg] &gt; Average On Off</td>
</tr>
<tr>
<td></td>
<td>VAvg - video average</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PAvg - power average</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Display line</td>
<td>[Det/Display] &gt; display Line On Off</td>
</tr>
<tr>
<td>27</td>
<td>Optimized Phase a</td>
<td>[Marker] &gt; Function &gt; Optimize Phase Noise</td>
</tr>
</tbody>
</table>

a. Optimized Phase is only available when SPAN doesn’t exceed 50 kHz.
Rear Panel Overview

1 **REF OUT connector** provides a frequency of 10 MHz, amplitude of –10 dBm reference output. (BNC female)

2 **REF IN connector** accepts an external timebase with a frequency of 10 MHz, amplitude of –5 to +10 dBm (BNC female).

3 **Kensington Lock** lock the instrument and keep its safety.

4 **LAN port** is reserved for future expansion.

5 **EXT TRG IN (TTL) connector** accepts an external voltage input, the positive edge of which triggers the analyzer sweep function (BNC female).

6 **Power switch** isolates the analyzer from the AC line power. After switch on, the analyzer enters into standby mode and the orange standby LED on the front panel lights.

7 **AC power receptacle** accepts a three-pin line power plug.

8 **VGA connector** provides the video output signal to an external monitor or projector (D-sub 15-pin female).

9 **USB Host connector** provides a connection between the analyzer and an PC for remote control.
Front and rear panel symbols

The instruction manual symbol: indicates that the user must refer to specific instructions in the manual.

The CE mark: a registered trademark of the European Community.

Shows that this is an Industrial Scientific and Medical Group 1 Class A product. (CISPR 11, Clause 4)

The CSA mark: a registered trademark of the Canadian Standards Association International.

The ISM device complies with Canadian Interference-Causing Equipment Standard-001. Cet appareil ISM est conforme à la norme NMB-001 du Canada.

The C-Tick mark: a trademark registered to the Australian Communication Media Authority. It indicates compliance with all Australian EMC regulatory information.

marks the “on/standby” position of the switch.

indicates that the instrument requires AC power input.

indicates this product complies with the WEEE Directive (2002/96/EC) marking requirements and you must not discard this equipment in domestic household waste. Do not dispose in domestic household waste. To return unwanted products, contact your local Agilent office, or refer to http://www.agilent.com/environment/product/
1 Overview
Getting Started

Check the Shipment and Order List  12
Power Requirements  13
Safety Notice  15
Electrostatic Discharge Protection  16
Environmental Requirements  17
Power on and Check  18
Some helpful Tips  20
Remote Control  22

This chapter gives you the information to start using the spectrum analyzer correctly.
Check the Shipment and Order List

After receiving the shipment, first check the shipment and your order list according to the following procedure.

- Inspect the shipping container for damage.
  Signs of damage may include a dented or torn shipping container or cushioning material that indicate signs of unusual stress or compacting.

- Carefully remove the contents from the shipping container and verify that your order is complete. Each spectrum analyzer includes the following items as standard:

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>N9320A Spectrum Analyzer</td>
<td>1</td>
<td>N9320A</td>
</tr>
<tr>
<td>USB cable</td>
<td>1</td>
<td>8121-1515</td>
</tr>
<tr>
<td>N-BNC adapter</td>
<td>1</td>
<td>1250-0780</td>
</tr>
<tr>
<td>BNC cable</td>
<td>1</td>
<td>8120-2682</td>
</tr>
<tr>
<td>Three-pin power cord</td>
<td>1</td>
<td>Specific to shipping location</td>
</tr>
<tr>
<td>User’s Guide</td>
<td>1</td>
<td>N9320-90001</td>
</tr>
<tr>
<td>Help kit CD-ROM</td>
<td>1</td>
<td>N9320-84500</td>
</tr>
<tr>
<td>Calibration certificate</td>
<td>1</td>
<td>5962-0476</td>
</tr>
</tbody>
</table>

- Verify if that the shipment includes your ordered options by checking the option label on the rear panel:

<table>
<thead>
<tr>
<th>Option</th>
<th>Name</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA3</td>
<td>3 GHz Preamplifier</td>
<td>N9320A-PA3</td>
</tr>
<tr>
<td>TG3</td>
<td>3 GHz Tracking Generator</td>
<td>N9320A-TG3</td>
</tr>
<tr>
<td>1HB</td>
<td>Handle and bumpers</td>
<td>N9320A-1HB</td>
</tr>
<tr>
<td>1CM</td>
<td>Rackmount kit</td>
<td>N9320A-1CM</td>
</tr>
<tr>
<td>1TC</td>
<td>Hard transit case</td>
<td>N9320A-1TC</td>
</tr>
</tbody>
</table>

For any questions about your shipment, please Contact Agilent Technologies for consulting and service.
Power Requirements

The spectrum analyzer has an auto-ranging line voltage input. The AC power supply must meet the following requirements:


<table>
<thead>
<tr>
<th>Parameter</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>100 to 240 VAC (90 to 264 VAC)</td>
</tr>
<tr>
<td>Frequency</td>
<td>50 to 60 Hz</td>
</tr>
<tr>
<td>Power</td>
<td>Maximum 100 W</td>
</tr>
</tbody>
</table>

AC Power Cord

The analyzer is equipped with a three-wire power cord, in accordance with international safety standards. This cable grounds the analyzer cabinet when connected to an appropriate power line outlet. The cable appropriate to the original shipping location is included with the analyzer.

Various AC power cables are available that are unique to specific geographic areas. You can order additional AC power cables for use in different areas. The table **AC Power Cords** lists the available AC power cables, the plug configurations, and identifies the geographic area in which each cable is appropriate.

The detachable power cord is the product disconnecting device. It disconnects the mains circuits from the mains supply before other parts of the product. The front panel switch is only a standby switch and do not disconnect instrument from LINE power.
### AC Power Cords

<table>
<thead>
<tr>
<th>Plug Type</th>
<th>Cable Part Number</th>
<th>Plug Description</th>
<th>For use in Country &amp; Region</th>
</tr>
</thead>
<tbody>
<tr>
<td>250V 10A</td>
<td>8121-1703</td>
<td>BS 1363/A</td>
<td>Option 900 United Kingdom, Hong Kong, Singapore, Malaysia</td>
</tr>
<tr>
<td>250V 10A</td>
<td>8120-0696</td>
<td>AS 3112:2000</td>
<td>Option 901 Australia, New Zealand</td>
</tr>
<tr>
<td>250V 16A</td>
<td>8120-1692</td>
<td>IEC 83 C4</td>
<td>Option 902 Continental Europe, Korea, Indonesia, Italy, Russia</td>
</tr>
<tr>
<td>125V 10A</td>
<td>8120-1521</td>
<td>CNS 10917-2 /NEMA 5-15P</td>
<td>Option 903 United States, Canada, Taiwan, Mexico</td>
</tr>
<tr>
<td>250V 10A</td>
<td>8120-2296</td>
<td>SEV 1011</td>
<td>Option 906 Switzerland</td>
</tr>
<tr>
<td>230V 15A</td>
<td>8120-4600</td>
<td>SABS 164-1</td>
<td>Option 917 South Africa, India</td>
</tr>
<tr>
<td>125V 15A</td>
<td>8120-4754</td>
<td>JIS C8303</td>
<td>Option 918 Japan</td>
</tr>
<tr>
<td>250V 16A</td>
<td>8120-5181</td>
<td>SI 32</td>
<td>Option 919 Israel</td>
</tr>
<tr>
<td>250V 10A</td>
<td>8120-8377</td>
<td>GB 1002</td>
<td>Option 922 China</td>
</tr>
</tbody>
</table>

a. Plug description describes the plug only. The part number is for the complete cable assembly.
Safety Notice

Please read the following warnings and cautions carefully before you power on the spectrum analyzer to ensure your personal and instrument safety.

**WARNING**
Always use a well-grounded, three-pin AC power cord to connect to power source. Personal injury may occur if there is any interruption of the AC power cord. Intentional interruption is prohibited. If this product is to be energized via an external auto transformer for voltage reduction, make sure that its common terminal is connected to a neutral (earthed pole) of the power supply.

**WARNING**
Personal injury may result if the spectrum analyzer covers are removed. There are no operator service parts inside. To avoid electrical shock, refer servicing to qualified personnel.

**WARNING**
Electrical shock may result if the spectrum analyzer is connected from the power supply while cleaning. Do not attempt to clean internally.

**CAUTION**
To install the spectrum analyzers in other racks, note that they may promote shock hazards, overheating, dusting contamination, and inferior system performance. Consult your Agilent customer engineer about installation, warranty, and support details.

**CAUTION**
Ensure protection of the input mixer by limiting average continuous power input to +30 dBm, DC voltage to 50 VDC, maximum pulse voltage to 125 V, or it may result in instrument damage.
Electrostatic Discharge Protection

Electrostatic discharge (ESD) damages or destroys electronic components (the possibility of unseen damage caused by ESD is present whenever transportation, store or use of components).

This product contains components that are easily damaged by electrostatic discharge. To help reduce ESD damage that can occur while using test equipment:

1 Before connecting any coaxial cable to the spectrum analyzer connector for the first time each day, momentarily short the center and outer conductors of the cable together.

2 Personnel should be grounded with a 1 MΩ resistor-isolated wrist-strap before touching the center pin of any connector, and before removing any assembly from the spectrum analyzer.

3 Be sure that all instruments are properly grounded to prevent build-up of static charge.

For more information about ESD and how to prevent ESD damage, contact the Electrostatic Discharge Association (http://www.esda.org). The ESD standards developed by this agency are sanctioned by the American National Standards Institute (ANSI).
Environmental Requirements

Agilent Technologies has designed this product for use in Installation Category II, Pollution Degree 2, per IEC 61010-1. Agilent has designed the spectrum analyzer for use under the following conditions:

- Indoor use
- Altitude < 3,000 meters
- Operating temperature range: +5 to +45 °C;
  Storage temperature range: –20 to +70 °C
- Relative humidity range 15% to 95%

Ventilation

Ventilation holes are located on the rear panel and one side of the spectrum analyzer cover. Do not allow these holes to be obstructed, as they allow air flow through the spectrum analyzer.

When installing the spectrum analyzer in a cabinet, do not restrict the convection of the analyzer. The ambient temperature outside the cabinet must be less than the maximum operating temperature of the spectrum analyzer by 4 °C for every 100 watts dissipated within the cabinet.

Cleaning Tips

To prevent electrical shock, disconnect the spectrum analyzer from line power before cleaning. Use a dry cloth or one slightly dampened with water to clean the external case parts. Do not attempt to clean internally.
Power on and Check

1. Connect the power cord. Insert the plug into a power socket provided with a protective earth. Set the tilt adjustor for your preference.

2. Press the line switch \( \text{on the rear panel. The standby LED (orange) will light and the spectrum analyzer is in standby mode.} \)

3. Press the standby switch \( \text{on the front panel. The Line LED (green) will light, and the spectrum analyzer boots up.} \)

Self-initialization takes about 25 seconds; the spectrum analyzer then defaults to the menu mode. After power on, let the spectrum analyzer warm up for 45 minutes for stabilization.

**NOTE**

The front panel switch is a standby switch only; it is not a power switch. To disconnect the spectrum analyzer from the line power, shut off the power switch on the rear panel.
Check for Instrument Messages

The spectrum analyzer has two categories of instrument messages: error and warning messages. A error message is triggered by operation errors, for example, setting conflicts or data input is out of the range of a parameter. An warning message mainly is triggered by hardware defects which could result in damage to instrument.

Here are some tips to check the instrument messages.

1. Check the display to see if any messages display in the status bar. Press \[ \text{Press System} \] \( \rightarrow \) \( \text{More} \) \( \rightarrow \) \( \text{Show Errors} \) to review each messages. Please refer to Chapter 6, “Instrument Messages” for detailed system messages descriptions.

2. When you have reviewed and resolved all of the error messages, press \[ \text{Press System} \] \( \rightarrow \) \( \text{More} \) \( \rightarrow \) \( \text{Show Errors} \) \( \rightarrow \) \( \text{Clear error queue} \) to delete the messages.

3. Cycle the power on the analyzer and then check again if the Instrument messages is still there.

4. If you can not resolve all error messages, please contact Customer Contact Center for service.
Some helpful Tips

Please refer to the following descriptions for your further use, including alignment, external reference, firmware update and option activation.

Running Internal Alignments

To meet specifications, the analyzer must be manually aligned.

When the alignment runs, you will hear clicking as the attenuator settings changing. This is not an indication of trouble.

**NOTE**

Manually Performing an Alignment

1. Connect a BNC cable with N-BNC adapter between the **CAL OUT** and **RF IN** connector.
2. After warm-up, press > Alignment > Align > All.
   Please refer to “Alignment” on page 93 for details.

Enable the Options

You are required to enter the option license key to enable the option. Contact your nearest Agilent Office for purchasing a license. Please refer to the procedures below to activate the options you have purchased. (option TG3 and option PA3)

1. Press > More > More > Licensing > Option
2. Enter the option number which you want to enable, Press [Enter] to confirm your input.
3. Press > More > More > Licensing > License key
4. Enter and terminate the license input. The option will be enabled immediately.
Using an External Reference

If you wish to use an external 10 MHz source as the reference frequency, connect an external reference source to the REF IN connector on the rear panel. An EXT REF indicator will display in the upper bar of the display. The signal level range is –5 to +10 dBm.

Firmware Revision

Press > More > Show software to view the firmware revision of your analyzer. If you call Agilent Technologies regarding your analyzer, it’s helpful to have this revision and the analyzer serial number available. To update the firmware, please refer to

http://www.agilent.com/find/n9320

Follow this procedure to finish the firmware update:

1. Download the firmware update package to the root directory of your USB storage device. Do not put this package into any other folders when updating.

2. Insert this USB storage device into the USB connector of front panel.

3. Power on your spectrum analyzer, the instrument will perform the update process automatically.

**CAUTION**

Any interruption during the update process will result in update failure and system data lost. Do not remove the USB storage device until the update is finished.

After this procedure, you will get your spectrum analyzer with latest version firmware.
Remote Control

The N9320A spectrum analyzer provides USB connection to your PC, allowing you run the analyzer in remote mode.

The configuration of setting up a remote control for your N9320A is simple: connect your N9320A and PC which has installed Agilent IO Libraries Suite with a USB cable.

When you connect your PC with the spectrum analyzer, power on your spectrum analyzer, the PC detects if there is a connection of the spectrum analyzer.

If you need the remote control more flexible, you can also build up your own program by using the SCPI commands.

For more information about Agilent IO Libraries Suite, refer to http://www.agilent.com/find/iolib

For further information on remote control and programming, please refer to the N9320A Programmer’s Guide in the N9320A Help Kit CD.
This chapter provides information on the functions and some specified measurements of the spectrum analyzer.

We assume that you understand the front and rear panel layout, and display annotations of your analyzer. If you do not, please refer to “Agilent N9320A at a Glance” on page 2.
Making a Basic Measurement

In this guide, the keys labeled a [ ]], for example, [Preset/System] is front-panel hardkeys. Pressing most of the hardkeys accesses menus of functions that are displayed along the right side of the screen, for example, Preset Type. These displayed functions are called softkeys.

Using the Front Panel

This section provides you with the information on how to use the front panel of the spectrum analyzer.

Entering Data

When setting measurement parameters, there are several ways to enter or modify the value of the active function:

- **Knob**: Increments or decrements the current value.
- **Arrow Keys**: Increments or decrements the current value by step.
- **Numeric Keys**: Enters a specific value. Then press the desired terminator (either a unit softkey, or [Enter] hardkey).
- **Unit Softkeys**: Terminate a value that requires a unit of measurement.
- **Enter Key**: Terminates an entry when either no unit of measure is needed, or you want to use the default unit.
- **Back Key**: Delete the current input digit before you terminate the input.

Using Softkeys

Softkeys provide access to the analyzer functions. Here are examples of softkey types:

- **Toggle**: Activates/deactivates the states.
- **Submenu**: Displays a secondary menu of softkeys.
- **Choice**: Makes a selection from a list of values.
- **Adjust**: Highlights the softkey and sets the active function.
Presetting the Spectrum Analyzer

Preset provides a known instrument status for making measurements. There are two types of preset:

- **Factory Preset**: Restores the analyzer to its factory-defined state. Please refer to “Factory Preset State” on page 92 for details.

- **User Preset**: Restores the analyzer to a user-defined state.

Press `System` > `Pwr on/Preset` > `Preset Type` to select the preset type.

When `Preset Type` sets to **Factory**, pressing `System` > `Preset` triggers a factory preset.

When `Preset Type` sets to **User**, pressing `System` > `Preset` displays both **User Preset** and **Factory Preset** softkeys, then select the preset you need.

Setting up a User Preset

If you constantly use settings that are not the factory defaults, use the following steps to set up a user-defined preset:

1. Set customized parameters as required.
2. Press `System` > `Pwr on/Preset` > `Save User Preset`, to save current instrument settings as the ‘user preset’ state. The user preset do not affect the default factory preset settings.

Viewing a Signal

Refer to the procedures below to view a simple signal.

1. Press `System` > `Pwr on/Preset` > `Preset Type` > **Factory** to enable the factory-defined preset state.
2. Press `System` > `Preset` to restore the analyzer to its factory-defined state.
3. Connect 10 MHz `REF OUT` on the rear panel to the front-panel `RF IN`. 
3 Functions and Measurements

**Setting Reference Level and Center Frequency**

1 Press ![Amplitude](> 10 > dBm) to set 10 dBm reference level.
2 Press ![Frequency](> 30 > MHz) to set 30 MHz center frequency.

**Setting Frequency Span**

Press ![SPAN](> 50 > MHz) to set 50 MHz frequency span.

**NOTE**

Changing the reference level changes the amplitude value of the top graticule line. Changing the center frequency changes the horizontal placement of the signal on the display. Increasing the span increases the frequency range that appears horizontally across the display.

**Reading Frequency and Amplitude**

1 Press ![Peak](Search) to place a marker (labeled 1) on the 10 MHz peak.

Note that the frequency and amplitude of the marker appear both in the active function block, and in the upper-right corner of the screen.

**Figure 1 10 MHz Internal Reference Signal**
2 Use the knob, the arrow keys, or the softkeys in the **Peak Search** menu to move the marker. The marker information will display in the upper-right corner of the screen.

**Changing Reference Level**

1 Press \(\text{Amplitude}\) and note that reference level (Ref Level) is now the active function.

2 Press \(\text{Marker} \rightarrow \text{Mkr} \rightarrow \text{Ref Lvl}\).

Note that changing the reference level changes the amplitude value of the top graticule line.
Measuring Multiple Signals

This section provides the information on how to measure multiple signals.

Comparing Signals on the Same Screen Using Marker Delta

This analyzer delta marker function lets you compare two signals when both appear on the screen at one time.

In the following example, harmonics of the 10 MHz reference signal available at the rear of the analyzer is used to measure frequency and amplitude differences between two signals on the same screen. Delta marker is used to demonstrate this comparison.

1. Preset the analyzer:
   Press \textbf{Preset} (With \textbf{Preset Type} of \textbf{Factory})

2. Connect the rear panel \textbf{REF OUT} to the front panel \textbf{RF IN}.

3. Set the analyzer center frequency, span and reference level to view the 10 MHz signal and its harmonics up to 50 MHz:
   Press \textbf{Frequency} > 30 > MHz
   Press \textbf{SPAN} > 50 > MHz
   Press \textbf{Amplitude} > 10 > dBm

4. Place a marker at the highest peak on the display (10 MHz):
   Press \textbf{Peak Search}

   The marker should be on the 10 MHz reference signal. Use the \textbf{Next Pk Right} and \textbf{Next Pk Left} softkeys to move the marker from peak to peak.

5. Anchor the first marker and activate a second marker:
   Press \textbf{Marker} > \textbf{Delta} > \textbf{Delta (On)}

   The label on the first marker now reads 1R, indicating that it is marking the reference point.

6. Move the second marker to another signal peak using the front-panel knob or by using \textbf{Peak Search}.  
Press > Next Peak or

Press > Next Pk Right or Next Pk Left.

The amplitude and frequency differences between the markers are displayed in the active function block.

**Figure 2** Delta pair marker with signals on the same screen

---

**NOTE**

To increase the resolution of the marker readings, turn on the frequency count function. For more information, please refer to “Improving Frequency Resolution and Accuracy” on page 41.
Comparing Signals not on the Same Screen
Using Marker Delta

The analyzer helps you to compare the frequency and amplitude difference between two signals which are not on the same screen. (This technique is useful for harmonic distortion tests.)

In this example, the analyzer’s 10 MHz signal is used to measure frequency and amplitude differences between one signal on screen and one signal off screen. Delta marker is used to demonstrate this comparison.

1 Preset the analyzer:
   Press > Preset (With Preset Type set to Factory)

2 Connect the rear panel REF OUT to the front panel RF IN.

3 Set the center frequency, span and reference level to view only the 50 MHz signal:
   Press > Frequency > Center Freq > 50 > MHz
   Press > Span > 25 > MHz
   Press > Amplitude > Ref Level > 10 > dBm

4 Place a marker on the 10 MHz peak and then set the center frequency step size equal to the marker frequency (10 MHz):
   Press > Mkr -> CF Step

5 Activate the marker delta function:
   Press > Marker > Delta > Delta (On)

6 Increase the center frequency by 10 MHz:
   Press > Frequency > Center Freq, 0

The first marker moves to the left edge of the screen, at the amplitude of the first signal peak.
**Figure 3** shows the reference annotation for the delta marker (1R) at the left side of the display, indicating that the 10 MHz reference signal is at a lower frequency than the frequency range currently displayed.

**Figure 3  Delta Marker with Reference Signal Off-Screen**

The delta marker appears on the peak of the 100 MHz component. The delta marker annotation displays the amplitude and frequency difference between the 10 and 100 MHz signal peaks.

7 Press **Marker > Off** to turn the markers off.
Resolving Signals of Equal Amplitude

In this example a decrease in resolution bandwidth is used in combination with a decrease in video bandwidth to resolve two signals of equal amplitude with a frequency separation of 100 kHz.

**Figure 4** Setup for obtaining two signals

![Setup diagram]

Notice that the final RBW selection to resolve the signals is the same width as the signal separation while the VBW is slightly narrower than the RBW.

1. Connect two sources to the analyzer input as shown above.
2. Set one source to 300 MHz. Set the frequency of the other source to 300.1 MHz. Set both source amplitudes to –20 dBm.
3. Setup the analyzer to view the signals:
   - Press > Preset (With Preset Type of Factory)
   - Press > 300 > MHz
   - Press > 300 > kHz
   - Press > 2 > MHz

A single signal peak is visible. See Figure 5 for example.
If the signal peak is not present on the display, span out to 20 MHz, turn signal tracking on, span back to 2 MHz and turn signal tracking off:

Press `SPAN > Span > 20 > MHz`
Press `Peak Search`
Press `Frequency > Signal Track (On)`
Press `SPAN > 2 > MHz`
Press `Frequency > Signal Track (Off)`

4 Change the resolution bandwidth (RBW) to 100 kHz so that the RBW setting is less than or equal to the frequency separation of the two signals:

Press `BW > 100 > kHz`

Notice that the peak of the signal has become flattened indicating that two signals are present.

5 Decrease the video bandwidth to 3 kHz:

Press `BW > Video BW > 3 > kHz`

Two signals are now visible as shown in Figure 6. Use the front-panel knob or arrow keys to further reduce the resolution bandwidth and better resolve the signals.
Decreasing the resolution bandwidth improves the resolution of the individual signals and increase the sweep time.

**Figure 6  Resolving Signals of Equal Amplitude**

For fastest measurement times, use the widest possible resolution bandwidth. Under factory preset conditions, the resolution bandwidth is coupled to the span.
Resolving Small Signals Hidden by Large Signals

This example uses narrow resolution bandwidths to resolve two input signals with a frequency separation of 50 kHz and an amplitude difference of 60 dB.

1. Connect two sources to the RF IN as shown in Figure 4.
2. Set one source to 300 MHz at –10 dBm. Set the other source to 300.05 MHz at –70 dBm.
3. Set the analyzer as follows:
   - Press > Preset. (With Preset Type of Factory)
   - Press > 300 > MHz
   - Press > 30 > kHz
   - Press > 500 > kHz
4. Set the 300 MHz signal to the reference level:
   - Press Peak Search
   - Press Marker > Mkr -> Ref Lel

The 30 kHz filter shape factor of 15:1 has a bandwidth of 450 kHz at the 60 dB point. The half-bandwidth (225 kHz) is NOT narrower than the frequency separation of 50 kHz, so the input signals can not be resolved.
5 Reduce the resolution bandwidth filter to view the smaller hidden signal. Place a delta marker on the smaller signal:

- Press BN > 1 > kHz
- Press Peak Search
- Press Marker > Delta > Delta (On)
- Press 50 > kHz

**Figure 8** Resolved small signal from large signal

**NOTE** The 1 kHz filter shape factor of 15:1 has a bandwidth of 15 kHz at the 60 dB point. The half-bandwidth (7.5 kHz) is narrower than the frequency separation of 50 kHz, so the input signals can be resolved.
Measuring a Low-Level Signal

This section provides information on measuring low-level signals and distinguishing them from spectrum noise.

Reducing Input Attenuation

The ability to measure a low-level signal is limited by internally generated noise in the spectrum analyzer. The input attenuator affects the level of a signal passing through the analyzer. If a signal is close to the noise floor, reducing input attenuation will bring the signal out of the noise.

Ensure that the total power of all input signals at the analyzer RF input does not exceed +30 dBm (1 Watt).

1. Preset the analyzer
   Press \texttt{Preset/ System} > \texttt{Preset} (With \texttt{Preset Type} of \texttt{Factory})

2. Set the source frequency to 300 MHz, amplitude to $-70$ dBm. Connect the source \texttt{RF OUT} to the analyzer \texttt{RF IN}.

   \textbf{Figure 9} Setup for obtaining one signal

3. Set the center frequency, span and reference level:
   Press \texttt{Frequency} > \texttt{Center Freq} > 300 > MHz
   Press \texttt{SPAN} > \texttt{Span} > 2 > MHz
   Press \texttt{Amplitude} > \texttt{Ref Level} > 40 > –dBm.

4. Move the desired peak to the center of the display:
3 Functions and Measurements

Press \[ \text{Peak} \] > \text{Search} > \text{Marker} > \text{CF} \]

5 Reduce the span to 500 kHz, if necessary re-center the peak:
Press \[ \text{SPAN} > 500 > \text{kHz} \]

6 Set the attenuation to 20 dB:
Press \[ \text{Amplitude} > \text{Attenuation} > 20 > \text{dB} \]

Figure 10 A signal closer to the noise level

Note that increasing the attenuation moves the noise floor closer to the signal level.

7 To view the signal more clearly, set the attenuation to 0 dB:
Press \[ \text{Amplitude} > \text{Attenuation} > 0 > \text{dB} \]

Figure 11 Measuring a low-level signal using 0 dB Attenuation
Decreasing the Resolution Bandwidth

Resolution bandwidth settings affect the level of internal noise without affecting the level of continuous wave (CW) signals. Decreasing the RBW by a decade reduces the noise floor by 10 dB.

1. Refer to the first procedure “Reducing Input Attenuation” on page 37 and follow steps 1, 2 and 3.

2. Decrease the resolution bandwidth:

Press and  

The low-level signal appears more clearly because the noise level is reduced (see Figure 12).

Figure 12  Decreasing Resolution Bandwidth

A “#” mark appears next to the Res BW annotation in the lower left corner of the screen, indicating that the resolution bandwidth is uncoupled.

Note

The analyzer allows you to change the RBW in a 1-3-10 sequence by the data control keys. The RBWs below 1 kHz are digital and have a selectivity ratio of 5:1 while RBWs at 1 kHz and higher have a 15:1 selectivity ratio. The maximum RBW is 3 MHz and minimum is 10 Hz.
Trace Averaging

Averaging is a digital process in which each trace point is averaged with the previous average value for the same trace point. Selecting averaging, when the analyzer is auto-coupled, changes the detection mode to Sample, smoothing the displayed noise level.

This is a trace processing function and is not the same as using the average detector (as described on page 39).

1 Refer to the first procedure “Reducing Input Attenuation” of this chapter and follow steps 1, 2 and 3.

2 Turn average on:

   Press \texttt{BW/Avg} \textgreater \texttt{Average (On)}

3 Set the number of averages to 20:

   Press \texttt{20, Enter}

Since the averaging routine smooths the trace, low level signals become more visible (see Figure 13).

\textbf{Figure 13 Trace Averaging}
Improving Frequency Resolution and Accuracy

This section provides information on how to improve frequency resolution and accuracy using the frequency counter function.

1. Press \texttt{Preset} (With \texttt{Preset Type} of \texttt{Factory})

2. Connect a cable from the front panel \texttt{CAL OUT} to \texttt{RF IN};

Then, Press \texttt{Alignment} > \texttt{Align} > \texttt{CAL OUT ON} to enable the 50 MHz amplitude reference signal.

3. Press \texttt{Auto Tune}

The analyzer detects the peak of the signal and locate it to the center of the graticule (Refer to “Auto Tune” on page 60).

4. Turn the frequency counter on:

Press \texttt{Marker} > \texttt{Function} > \texttt{Freq Counter} > \texttt{Freq Counter (On)}.

5. Move the marker, with the front-panel knob, half-way down the skirt of the signal response.

\textbf{Figure 14 Using Frequency Counter}

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{figure14.png}
\caption{Using Frequency Counter}
\end{figure}

\textbf{NOTE}

The frequency and amplitude of the marker appears in the active function area (this is not the counted result). The counted result appears in the upper-right corner of the display to the right-side of \texttt{Cntr1}.
3 Functions and Measurements

Notice that the readout in the active frequency function changes while the counted frequency result (upper-right corner of display) does not. To get an accurate count, you do not need to place the marker at the exact peak of the signal response.

**NOTE**

Frequency counter properly functions only on CW signals or discrete spectral components. The marker must be greater than 40 dB above the displayed noise level.

---

6 Change counter resolution:

Press **Marker** > **Function** > **Freq Counter** > **Resolution**

The frequency-counter resolution ranges from 1 Hz to 1 kHz.

7 Turn off the marker counter:

Press **Marker** > **Function** > **Freq Counter** > **Freq Counter (Off)**.

**NOTE**

When using the frequency counter function, the ratio of the resolution bandwidth to the span must be greater than 0.02.
Tracking Drifting Signals

This section provides information on measuring and tracking signals that drift.

Measuring a Source’s Frequency Drift

The analyzer allows you to measure the stability of a source. The maximum amplitude level and the frequency drift of an input signal trace can be displayed and held by using the maximum hold function. Using the maximum hold function also allows you to determine how much of the frequency spectrum a signal occupies. For more information, please refer to “Max Hold” on page 100.

Use signal tracking to keep a drifting signal in the center of the display. The drifting is captured by the analyzer using maximum hold.

1. Connect the signal generator to the analyzer RF IN.

2. Output a signal with the frequency of 300 MHz and amplitude of –20 dBm.

3. Set the analyzer center frequency, span and reference level.
   Press \( > \text{Preset.} \) (With \( \text{Preset Type of Factory} \))
   Press \( > \text{Center Freq} > 300 > \text{MHz} \)
   Press \( > \text{Span} > 10 > \text{MHz} \)
   Press \( > \text{Ref Level} > –10 > \text{dBm} \)

4. Place a marker on the peak of the signal and turn signal tracking on:
   Press \( > \text{Signal Track (On)} \)
   Press \( > 1 > \text{MHz} \)

Notice that this holds the signal in the center of the display.
5 Turn off the signal track function:
Press \textit{Frequency} > \textit{Signal Track (Off)}

6 Measure the excursion of the signal with maximum hold:
Press \textit{View/Trace} > \textit{Max Hold}

As the signal varies, maximum hold maintains the maximum responses of the input signal. Annotation on the left side of the screen indicates the trace mode. For example, M1 S2 S3 indicates trace 1 is in maximum-hold mode, trace 2 and trace 3 are in store-blank mode.

7 Activate trace 2 and change the mode to continuous sweep:
Press \textit{View/Trace} > \textit{Select Trace > Trace 2}
Press \textit{Clear Write}

Trace 1 remains in maximum hold mode to show any drift in the signal.

8 Slowly change the frequency of the signal generator. Your analyzer display should look similar to Figure 15.

\textbf{Figure 15} \textit{Viewing a Drifting Signal With Max Hold and Clear Write}
Making Distortion Measurements

This section provides information on measuring and identifying signal distortion.

Identifying Analyzer Generated Distortion

High-level input signals may cause analyzer distortion products that could mask the real distortion measured on the input signal. Use trace and the RF attenuator to determine which signals, if any, are internally generated distortion products.

In this example, we use a signal from a signal generator to determine whether the harmonic distortion products are generated by the analyzer.

1. Connect the signal generator to the analyzer RF IN.
2. Set the source frequency to 200 MHz, amplitude to 0 dBm.
3. Set the analyzer center frequency and span:
   - Press \[\text{Preset} \rightarrow \text{Preset}\]
   - Press \[\text{Frequency} \rightarrow 400 \rightarrow \text{MHz}\]
   - Press \[\text{SPAN} \rightarrow 500 \rightarrow \text{MHz}\]

![Figure 16 Harmonic Distortion](image)
3 Functions and Measurements

The signal produces harmonic distortion products (spaced 200 MHz from the original 200 MHz signal) in the analyzer input mixer as shown in Figure 16.

4 Change the center frequency to the value of the first harmonic:

Press > Next Peak
Press > Mkr -> CF

5 Change the span to 50 MHz and re-center the signal:

Press > 50 > MHz
Press
Press > Mkr -> CF

6 Set the attenuation to 0 dB:

Press > Attenuation > 0 > dB

7 To determine whether the analyzer generates harmonic distortion products, first display the trace data in trace 2 as follows:

Press > Select Trace > Trace 2
Press Clear Write

8 Allow trace 2 to update (minimum two sweeps), then store the data from trace 2 and place a delta marker on the harmonic of trace 2:

Press > View
Press
Press > Delta > Delta (On)

The analyzer display shows the stored data in trace 2 and the measured data in trace 1. The MarkerΔ indicator reads the difference in amplitude between the reference and active markers.

9 Increase the RF attenuation to 10 dB:

Press > Attenuation > 10 > dB
Notice the MarkerΔ amplitude readout. This is the difference of the distortion product amplitude between 0 dB and 10 dB input attenuation settings. If the MarkerΔ absolute amplitude is approximately ≥1 dB for an input attenuator change, the analyzer is generating, at least in part, the distortion.

The MarkerΔ amplitude readout comes from two sources:

1) Increased input attenuation causes poorer signal-to-noise ratio. This causes the MarkerΔ to be positive.

2) The reduced contribution of the analyzer circuits to the harmonic measurement causes the MarkerΔ to be negative.

Large MarkerΔ readout indicates significant measurement errors. Set the input attenuator to minimize the absolute value of MarkerΔ.
Third-Order Intermodulation Distortion

Two-tone, third-order intermodulation distortion is a common test in communication systems. When two signals are present in a non-linear system, they may interact and create third-order intermodulation distortion (TOI) products that are located close to the original signals. System components such as amplifiers and mixers generate these distortion products.

For an example of the quick setup of TOI measurement, refer to “Intermod (TOI)” on page 110.

This example tests a device for third-order intermodulation using markers. Two sources are used, one set to 300 MHz and the other to 301 MHz.

1 Connect the equipment as shown in figure below. This combination of signal generators, low pass filters, and directional coupler (used as a combiner) results in a two-tone source with very low intermodulation distortion. Although the distortion from this setup may be better than the specified performance of the analyzer, it is useful for determining the TOI performance of the source/analyzer combination. After the performance of the source/analyzer combination has been verified, the device-under-test (DUT) (for example, an amplifier) would be inserted between the directional coupler output and the analyzer input.
2 Set one source (signal generator) to 300 MHz and the other source to 301 MHz, for a frequency separation of 1 MHz. Set the sources equal in amplitude as measured by the analyzer (in this example, they are set to −5 dBm).

3 Set the analyzer center frequency and span:
- Press \( \text{Preset} \rightarrow \) Preset (With Preset Type of Factory)
- Press \( \text{Frequency} \rightarrow \) Center Freq > 300.5 MHz
- Press \( \text{SPAN} \rightarrow \) Span > 5 MHz

4 Reduce the RBW until the distortion products are visible:
- Press \( \text{BW-Avg} \) and \( \odot \)

5 Move the signal to the reference level:
- Press \( \text{Search} \)
- Press \( \text{Marker} \rightarrow \) Mkr -> Ref Lvl

6 Reduce the RBW until the distortion products are visible:
- Press \( \text{BW-Avg} \) and \( \odot \)

7 Activate the second marker and place it on the peak of the distortion product (beside the test signal) using the Next Pea:
- Press \( \text{Marker} \rightarrow \) Delta > Delta (On)
- Press \( \text{Peak Search} \rightarrow \) Next Peak

8 Measure the other distortion product:
- Press \( \text{Marker} \rightarrow \) Normal
- Press \( \text{Peak Search} \rightarrow \) Next Peak

NOTE The coupler should have a high degree of isolation between the two input ports so the sources do not intermodulate.
Measure the difference between this test signal and the second distortion product (see Figure 17):

Press **Marker** > **Delta** > **Delta (On)**
Press **Peak Search** > **Next Peak**

**Figure 17** Measuring the Distortion Product
Measuring Phase Noise

Phase noise is a frequency domain measure of stability. We specify phase noise as single-sideband power in relation to the fundamental RF output frequency, and measured at various offset frequencies from the carrier, normalized to a one hertz measuring bandwidth.

In this example the 50 MHz amplitude reference signal is used as the fundamental signal.

1. Press [Preset/ System] > Preset. (With Preset Type of Factory)
2. Connect a cable from the front panel CAL OUT to RF IN. Press [Preset/ System] > Alignment > CAL OUT On
3. Press [Auto Tune] to auto-tune the signal to the center of display.
4. Press [Peak Search] to place a marker on the peak of the signal.
5. Turn on the phase noise function to view the results:
   Press [Marker] > Function > Phase Noise > Phase Noise (On)
6. Change the offset:

Then change the offset by pressing the corresponding softkeys under the Phase Noise menu.
Viewing Catalogs and Saving Files

The analyzer stores and retrieves data similar as a PC. The analyzer allows you to view and save files in the internal storage or the USB storage device. This section provides information on how to locate catalogs and save a file.

Locating and Viewing Files in the Catalog

The analyzer has four types of files:

- **State**: stores analyzer settings. The extension is .STA.
- **Trace**: stores trace information. The extension is .TRA.
- **Screen**: stores screen captures of the display. The extension is .JPG.
- **Limits**: which stores data sets to determine whether a trace has exceeded preset specifications. The extension is .LIM.

Trace files are not bitmap files. It cannot be imported into other applications or converted. If you require the use of other applications, be sure to save as .JPG formats using **Screen** for your file type.

Press **Catalog** to bring up a screen display below.
The entry fields show the parameters for the files viewed:

- **Name** states the filename.
- **Type** displays the type of files viewed.
- **Path** displays the location of the files (Local or USB).

There are four column headings in this area of the display:

- **Name** displays the filename.
- **Type** displays the filename extension (TRA, STA, TRC or JPG).
- **Size** displays the size of the file in bytes.
- **Modified** displays the date and time the change occurred.

The softkey menu has four options:

- **Type** selects the type of file you wish to view.
- **Sort** sorts and views the files according to a file attribute.
- **Local** accesses the internal storage to view files.
- **USB** accesses the external USB storage device to view files.

The drive space line shows the number of bytes used on the drive and the number of bytes still free on the drive.

### Saving a File

The analyzer allows you to save files (states, traces, limits or screens) to a USB storage device (USB/), or the internal storage (Local/). This example will show you how to save a trace to the internal storage (Local/).

1. Select a destination for the saved file. Assume you select the internal storage (Local/):
   
   Press File > Catalog > Local

2. Press Return > Save to access the Save menu.

3. Select the type of file. Assume you need to save a trace. The extension for this file type is .TRA:
   
   Press Type > Trace
Select the trace you need (1, 2, 3, 4 or all traces). Assume you need to save trace 3:

Press **Source > Trace 3**

Enter a filename by pressing **Name**. Assume you name the file “TEST1”. (The numeric keypad is also available for the filename.) Pressing **Enter** will terminate the entering and return to the **Save** menu.

The filename is composed of alpha (A-Z) or numeric (0-9) in any combination. The analyzer will not allow you to overwrite an existing file. If you enter a filename that already exists, the status bar will display the message: “File already exists”. If you do not edit a filename, the analyzer will automatically generate a name based on the type of file you are saving (State: STATE, Trace: TRACE, Limits: LIMIT, Screen: SCREEN). It also generates a three digit integer (starting at 000 and extending through 999, remembering the previously saved value through a power cycle) which it adds to the name, for example: TRACE056.TRC.

Press **Save Now** to save the file

“Saving Now” is displayed during this operation. In this example, the status bar displays “Local/TEST1.TRC file saved”.

**CAUTION**

When saving file to the USB storage device, never remove the USB device during the save operation to prevent unexpected data loss.

---

### Loading a File

1. Select the directory where your file is located. In this example, select the internal storage (Local/):
   
   Press **File > Catalog > Local**

2. Press **Return > Load** to access the **Load** menu

3. Select the type of file. Assume you need to load a trace file:
   
   Press **Type > Trace**
4 Using the knob or arrow keys to highlight the file you need. And then select the trace into which you wish to load the file. Assume you need to load file TEST1.TRC into Trace 2:

Press **Destination > Trace 2**.

5 Press **Load Now** to load the specified file. The status bar displays: “Local/TEST1.TRC file loaded”. Screen files cannot be loaded, which are just used in PC applications.

**Copying a File**

If you need to copy a file from the internal storage to the USB storage device, please refer to the following procedures:

1 Press **File > Catalog > Local** to select the path
2 Connect a USB storage device to the USB connector (DEV).
3 Select the type of file. Assume you need to copy a trace file:

Press **Return > Copy > Type > Trace**

4 Using the knob or arrow keys to highlight the file name you need. In this example, highlight the file **TEST1.TRC**.

5 Press **Copy Now** to execute the operation. A “Copying file” indicator displays. Then “/USB/TEST1.TRC file copied” appears on the status bar. You have now copied the file TEST1.TRC from the internal storage to the USB storage device.

**Deleting a File**

1 Press **File > Catalog > Local** to select the path
2 Press **Return > Delete** to access the **Delete** menu
3 Select the type of file. Assume you need to delete a trace file press **Type > Trace**

4 Using the knob or arrow keys to highlight the file name you want to load. In this example, selecting the file **TEST1.TRC**.

5 Press **Delete Now**. “Deleting file” indicates the operation is in process. Then, “Local/TEST1.TRC file deleted” shown on the status bar indicates the file has been deleted.
3 Functions and Measurements
4
Key Reference

This chapter describes each front panel hardkey and associated softkeys. The front panel keys in this chapter are listed alphabetically. The lower level softkeys are arranged as they appear in your analyzer menus.
4 Key Reference

Amplitude

Press \textit{Amplitude} activates the reference level function and accesses the amplitude softkeys.

\textbf{Ref Level} Sets the reference level. This function is activated when \textit{Amplitude} is pressed. The reference level is the amplitude power or voltage represented by the top line of the graticule on the display. Setting the reference level changes the absolute amplitude level (in the selected amplitude units) of the top graticule line.

Key access: \textit{Amplitude}

\textbf{Attenuation} Toggles the input attenuation between \textit{Auto} and \textit{Man} and sets the attenuation level in 5 dB increments when \textit{Man} is selected. The analyzer input attenuator, which is normally coupled to the reference level control, reduces the power level of the analyzer input signal at the input mixer. Selecting \textit{Auto} re-couples the attenuator. Change the attenuation by using the arrow keys, the knob, or the numeric keypad.

Key access: \textit{Amplitude}

\textbf{Scale/Div} Sets the logarithmic units per vertical graticule division on the display. The \textit{Scale/Div} function is available only when the \textit{Scale Type} key is set to \textit{Log}.

Key access: \textit{Amplitude}

\textbf{Scale Type} Scales the vertical graticule divisions in logarithmic units when \textit{Log} is selected. The valid logarithmic units are 1, 2, 5 and 10 dB per division. When \textit{Lin} is underlined, the vertical divisions are linearly scaled with default amplitude units of volts. The top of the graticule represents the reference-level value; the bottom of the graticule represents zero volts. (Each division is one-tenth of the reference level.)

Key access: \textit{Amplitude}
(Option PA3) Toggles the internal pre-amplifier function between on and off. Pressing **Int Preamp (On)** results in a correction being applied to compensate for the gain of the preamp. Amplitude readings then represent the signal value at the input connector. When the preamp is on, a “PA” indication appears on the left side of the display. The preamp operates over a range of 100 kHz to 3 GHz.

Key access:  

**Y Axis**  

Accesses the softkeys that change the amplitude units (logarithmic or linear). Change the amplitude units by pressing **dBm, dBmV, dBuV, dBuA, Watts, Volts**, and **Amps**.

Key access:  

**Int Preamp**

**On**  

**Off**
Auto Tune

Activates the autotune function to view the signal, This hardkey functions as following description:

1 Run Peak Search in full span
2 Run Mkr -> CF
3 Select the appropriate reference level according to the amplitude of searching signal.
4 Set span to 1 MHz and all auto couple to view the signal.

NOTE
The Auto Tune functions in the frequency range of 5 MHz to 3 GHz. The minimum detectable amplitude is –65 dBm.

For more information about Peak Search, Mkr -> CF and Mkr -> Ref Lel softkeys, please refer to “Peak Search” on page 87, and “Marker- >” on page 84.
The backspace key is located on the front panel and is used to change or correct an active function entry, or to change a text entry before you save data to a file.
BW/Avg

Activates the resolution bandwidth function and accesses the softkeys that control the bandwidth functions and averaging.

**Res BW**
- **Auto Man**
  - Changes the 3 dB resolution bandwidth of the analyzer from 10 Hz to 3 MHz using the knob or arrow keys. When under 1 kHz, the available bandwidth is 10, 30, 100 Hz or 300 Hz. If you enter an invalid bandwidth using the numeric keypad, the analyzer uses the closest available bandwidth. As the resolution bandwidth is decreased, the sweep time is modified to maintain amplitude calibration. Resolution bandwidth is also related to span. As span decreases, the resolution bandwidth decreases. As the resolution bandwidth changes, the video bandwidth, if VBW/RBW is set to **AUTO**, changes to maintain the VBW/RBW ratio.

  A “#” mark appears next to “Res BW” on the display when it is not coupled. To recouple the resolution bandwidth, press **Res BW (Auto)**.

  Key access:

**Video BW**
- **Auto Man**
  - Changes the analyzer post-detection filter from 1 Hz to 3 MHz using the knob or arrow keys. If you enter an invalid bandwidth, the analyzer use the closest available bandwidth. As the video bandwidth decreases, the sweep time increases to maintain amplitude calibration.

  A “#” mark appears next to “VBW” on the bottom of the analyzer display when it is not coupled. To couple the video bandwidth, press **Video BW (Auto)**.

  Key access:

**VBW/RBW**
- **Auto Man**
  - Sets the ratio between the video and resolution bandwidths. If a signal level close to noise level is visually masked by the noise, you need to set the ratio to less than 1 to lower the noise. When **Preset Type** is set to **Factory** and **Preset** is pressed, the ratio is set to 1. Change the ratio by using the arrow keys, knob, or numeric keypad. When **VBW/RBW (Auto)** is selected, the ratio is determined automatically by the rules in **Figure 18**.
Figure 18 VBW/RBW Ratio Auto Rules

Key access: \( \text{BW} / \text{Avg} \)

**Average On Off**

Initiates a digital averaging routine that averages the trace points in a number of successive sweeps resulting in trace “smoothing”. The number of sweeps (average number) is changeable when setting **Average (Off)**. Increasing the average number will further smooth the trace. pressing \( \text{BW} / \text{Avg} > \text{Avg Type} \) to select the type of averaging.

To restart averaging:
- Enter a new average number
- Change any related parameter (e.g., Center Frequency)

When in **sweep single**, the specified number of averages is taken, then the sweep stops and an average trace displayed.
When in continuous sweep mode, the specified number of averages is taken, then the averaging continues with each new sweep averaged in with a weight of \( \frac{1}{\text{AverageNumber}} \) and the old average reduced by multiplying it by \( \frac{1}{\text{AverageNumber}} \).

To turn averaging off, press Average (Off).

Key access:

**Avg Type**

Toggles the average type between automatic and manual. Selecting Auto sets the analyzer to automatic averaging by the rules in Figure 19.

**Man** sets the analyzer to manual averaging. When trace average is on, the average type is shown on the left side of the display. Selecting an average type manually causes the analyzer to use that type without regard to other analyzer settings and sets Avg Type to Man.

Key access:

**Video Avg** Video averaging averages the data as appropriate for the y-axis scale. When Avg Type > Video Avg is selected, “VAvg” appears on the left side of the analyzer display if Average is On.

Key access: \( \text{BW/Avg} > \text{Avg Type} \)

**Pwr Avg** Power averaging is performed by converting the trace data from logarithmic to linear power units, and then averaging the power trace data. When Avg Type > Pwr Avg is selected, “PAvg” appears on the left side of the screen if Average is On.

Key access: \( \text{BW/Avg} > \text{Avg Type} \)
Det/Display

Press this hardkey to control detector and display functions.

Selects a specific detector, or allows to pick the appropriate detector (through Auto) for a particular measurement.

When discussing detectors, it is important to understand what is a trace “bucket”. For every trace point displayed, there is a finite time during which the data for that point is collected. The analyzer look at all of the data collected during that time and present a single point of trace data based on the detector mode. We call the interval during which the data for that trace point is being collected, the “bucket”. Thus a trace is more than a series of single points. It is actually a series of trace “buckets”. The data may be sampled many times within each bucket.

Figure 20  Detector (auto) Selection Flowchart Rules
When the detector sets to **Auto**, Pressing > **Average (On)** changes the detector. The **Auto** choice depends on marker functions, trace functions, and the trace averaging function. If a marker function or measurement is running, the **Auto** choice of detector is either **Average** or **Sample**. When one of the detectors (such as **Average**) is manually selected instead of **Auto**, that detector is used without regard to other analyzer settings.

- **Average** displays the power average in the bucket.
- **Sample** displays the instantaneous level of the signal at the center of the bucket represented by each display point.
- **Positive Peak** displays the max. of the signal in the bucket.
- **Negative Peak** displays the min. of the signal in the bucket.

The detector in use is indicated on the left side of the display. A “#” will appear next to it if the detector has been manually selected.

Key access: Det/Display

**Auto**

Selects peak detection as the default. If a measurement arises where a different detection scheme would be better utilized, the system will use the alternate scheme.

Key access: Det/Display > **Detector Auto Man**

**Positive Peak**

Obtains the maximum video signal between the last display point and the present display point and stores this value in memory. It’s used primarily when measuring sinusoidal components. When **Positive Peak** is selected, “Peak” appears in the upper-left corner.

Key access: Det/Display > **Detector Auto Man**

**Negative Peak**

functions as peak detection, but selects the minimum video signal value. This detection should not be used to measure the accurate amplitude. “NPk” also appears in the upper-left corner, When **Negative Peak** is selected.

Key access: Det/Display > **Detector Auto Man**
Active Fctn
Position

Selects the screen position for the Active Function Display.
Depending on the type of trace data being viewed, you can move the Active Function Display position for less visual interference with your screen data.

Key access: > Active Fctn Position

Top
Displays the active function in the top-left corner of the display.
Key access: > Active Fctn Position

Center
Displays the active function in the center-left side of the display.
Key access: > Active Fctn Position

Bottom
Displays the active function in the bottom-left corner of the display.
Key access: > Active Fctn Position

Average Video RMS
measures the average value of the amplitude across each trace interval (bucket). When Average is selected, “Avg” appears on the left corner.

Key access: > Detector Auto Man

Sample
Sample detection is used primarily to display noise or noise-like signals. It should not be used to measure the accurate amplitude of non noise-like signals. In sample mode, the instantaneous signal value of the present display point is placed in memory. When Sample detection is selected, “Samp” appears in the upper-left corner of the display.

Key access: > Detector Auto Man

Normal
Selects the maximum and minimum video signal values alternately. When selecting Normal detection, “Norm” appears in the upper-left corner.

Key access: > Detector Auto Man
### Display Line

**On Off**

Activates an adjustable horizontal line that is used as a visual reference line. The line, which can be used for trace arithmetic, has amplitude values that correspond to its vertical position when compared to the reference level. The value of the display line appears in the active function block and on the left side of the display. Use the arrow keys, knob, or numeric keypad to adjust the display line. Pressing any digit, 0 through 9, on the numeric keypad brings up the selected terminator menu.

**Key access:**

### Limits

Accesses softkeys that allow you to create and define the parameters of limit lines.

**Key access:**

- **Limit 1** selects either of the available limits. The Limit 1 and Limit 2 keys access softkeys to set parameters for the selected limit.

**Key access:** > Limits

- **Type** defines the limit you are editing as either an upper or lower limit. An upper limit fails if trace 1 exceeds the limit. A lower limit fails if trace 1 falls below the limit.

**Key access:** > Limits > Limit 1/2

- **Limit On Off**

  Toggles the limit line between on and off. You need to edit the limit points before you turn on the limit function. Either Limit or Margin, as well as Test, must be turned on for a limit test.

**Key access:** > Limits > Limit 1/2
**Test On Off**
Toggles the testing of the limit lines between on and off. If trace 1 is at or within the bounds of the set limit or margin, “Limit_# Pass” or “Margin_# Pass” is displayed in the upper left corner of the measurement area limit line. Only positive/negative margins are allowed for lower/upper limits. If the trace is out of the limit or margin boundaries, “Limit_# Failed” or “Margin_# Failed” is displayed. Either Limit or Margin must be turned on for test.

Key access: > Limits > Limit 1/2

**Margin On Off**
Toggles the margin between on and off. Use Margin to set a limit line offset for the selected limit line. Either Limit or Margin as well as Test, must be turned on for a limit test to work.

Key access: > Limits > Limit 1/2

**Edit**
Accesses the submenu to edit the limit point, and also accesses the limits table. Use arrow keys to move between the rows in the limits table. New limit segments will only be applied after close the editor. Pressing Return, or any key not associated with the editor, will close the editor.

Key access: > Limits > Limit 1/2

**Point**
Creates or edit a limit point. Up to 20 points can be defined for each limit line. Enter the point number using the numeric keypad, then Press [Enter], or use the knob or arrow keys to move to an existing point.

Key access: > Limits > Limit 1/2 > Edit
Frequency
Edits the frequency value for a limit point. After editing, the limit table will place the frequency or time in correct order. For a new point, **Amplitude** defaults to 0 dBm and **Connected** defaults to **Yes**.

Key access: `> Limits > Limit 1/2 > Edit`

Amplitude
Sets the amplitude value for the current point.

Key access: `> Limits > Limit 1/2 > Edit`

Connected To Previous Pt
Yes No
Determines whether the current point will be connected to the previous point. Pressing this key toggles the **Connected** value of the current point between **Yes** and **No**.

Key access: `> Limits > Limit 1/2 > Edit`

Delete Point
Deletes the current point in the limit line. Pressing this key will delete the point immediately.

Key access: `> Limits > Limit 1/2 > Edit`

Delete Limit
Deletes the current limit set. Pressing this key will delete the limit immediately.

Key access: `> Limits > Limit 1/2`

Delete All Limits
Purges data from the limit-line tables. Pressing this key will delete all the limits immediately.

Key access: `> Limits`
**Enter**

Terminates a front-panel keypad numeric entry and enters that value into the analyzer. (For most applications, it is better to use the units softkeys to terminate value entry.) When in File menu, the [Enter] key is used to terminate filename entries.
File

Accesses the softkeys that allow you to manage the file system of the analyzer. Refer to “Viewing Catalogs and Saving Files” on page 52, for more information.

Catalog
Displays all files located on the selected catalog, depending upon the preferences set under the Type and Sort keys defined below.

Key access: 

Type
selects all types or one type of file(s) for viewing.

Default: State

Key access: > Catalog

All
Displays all files on the selected drive.

Key access: > Catalog > Type

Screen
Displays all screen (.JPG) files on the selected drive.

Key access: > Catalog > Type

State
Displays all state files (.STA) on the selected drive. State files contain most instrument settings.

Key access: > Catalog > Type

Trace
Displays all trace files (.TRA) on the selected drive.

Key access: > Catalog > Type

Limits
Displays all limits files (.LIM) on the selected drive.

Key access: > Catalog > Type

Sort
Sorts your files according to a selected file attribute, including By Date, By Name, and Order Up Down. Order (Up) sorts files in ascending order (such as A, B, C). Order (Down) allows you to sort files in descending order (such as C, B, A).

Key access: > Catalog
**Local**
Accesses the internal storage of the analyzer.
Key access: File/Print > Catalog

**USB**
Accesses the external USB storage device.
Key access: File/Print > Catalog

**Save**
Accesses menu keys that allow you to save analyzer screen, states, traces and limits data to a USB storage device or internal storage.
Key access: File/Print

**Save Now**
Executes the save function. When completed, the message “local(USB)/XXX file saved” (where XXX is the filename) will appear in the status bar.
Key access: File/Print > Save

**Type**
Selects the type of data for your save.
Key access: File/Print > Save

**Screen**
Displays all previously saved screen files (.JPG) and captures the current screen displayed in preparation to save it in a file (.JPG).
Key access: File/Print > Save > Type

**State**
Displays all saved state (.STA) files and detects the current state parameters in preparation to save into a file (.STA). State files include all settings but not traces or limits.
Key access: File/Print > Save > Type

**Trace**
Displays all previously saved trace files (.TRA) and detects the current trace in preparation to save it in a file (.TRA). Save individual traces or a group of traces.
Key access: File/Print > Save > Type
Limits Displays all previously saved limits files (.LIM) and detects the current limits in preparation to save them in a file (.LIM). Limits provide data sets to determine whether a trace has exceeded preset specifications.
Key access: File/Print > Save > Type

Source When Type is Trace, you can save trace 1, 2, 3 or 4 along with state. All Traces saves all traces in a single file, along with the state.
When Type is Limits, Source accesses the Limit 1 and 2 softkeys. Limit 1 and 2 provide data sets to determine whether a trace has exceeded preset specifications.
Key access: File/Print > Save

Name Accesses the softkeys to enter a filename.
Key access: File/Print > Save

NOTE Only capital letters (A-Z) and digits (0-9) may appear in file names. The instrument automatically adds a three character file extension.

Load Accesses a submenu to load analyzer states, traces and limits into the analyzer from a USB storage device or internal storage (Local).
Key access: File/Print

Load Now Executes the load function. When load completed, the message “local(usb)/XXX file loaded” (where XXX is the filename) appears in the status bar.
Key access: File/Print > Load

Type Selects the type of file for your load.
Key access: File/Print > Load
**State** Displays all state files for your load (.STA). Loading a state restores most settings to the saved values.

Key access: File > Load > Type

**Trace** Displays all trace files (.TRA) for your load. Load traces individually or as a group. Loading a trace also loads the current state, and sets the trace to view mode.

Key access: File > Load > Type

**Limits** Displays all limits files for your load to determine whether a trace has exceeded preset specifications (.LIM). Limits are loaded individually only.

Key access: File > Load > Type

**Sort** Accesses a submenu to view your saved files according to a selected file attribute. The selections include, *By Date*, *By Name*, and *Order Up Down*. *Order (Up)* sorts files in ascending order (such as A,B,C). *Order (Down)* sorts files in descending order (such as C,B,A).

Key access: File > Load

**Destination** With *Type* set to *Trace*, *Destination* directs the data to *Trace 1, 2, 3* or *4*. If the data is for all four traces (for instance, *Source* was *All Traces* when they were saved), the data returns to the original trace registers.

When *Type* is set to *Limits*, *Destination* allows you to direct your data to *Limit 1* or *Limit 2*.

Key access: File > Load

**Delete** Enter the submenu for deletion.

Key access: File
Delete Now  Executes the delete function. After a successful delete, the message “local(USB)/XXX file deleted” (where XXX is the filename) appears in the status bar on the display.

Key access: File/Print > Delete

Type  Selects the type of file to delete.

Key access: File/Print > Delete

All  Displays all files for deletion.

Key access: File/Print > Delete > Type

Screen  Displays screen files for deletion.

Key access: File/Print > Delete > Type

State  Displays state files for deletion.

Key access: File/Print > Delete > Type

Trace  Displays trace files for deletion.

Key access: File/Print > Delete > Type

Limits  Displays limits files for deletion.

Key access: File/Print > Delete > Type

Sort  Sorts the files according to a file attribute for deletion: By Date, By Name and Order Up Down. Order (Up) displays files in ascending order. Order (Down) displays files in descending order.

Key access: File/Print > Delete

Copy  Enter the submenu for copy files from local to usb storage device.

Key access: File/Print

Copy Now  Executes the copy function. If the copy is successful, “local/XXX file copied to USB” (where XXX is the filename) will appear in the status bar.

Key access: File/Print > Copy
**Type**  
Select the type of file to copy.  
Key access:  

- **All**  
  Displays all files for your copy.  
  Key access:  

- **Screen**  
  Displays all screen files for your copy.  
  Key access:  

- **State**  
  Displays all state files for your copy.  
  Key access:  

- **Trace**  
  Displays all trace files for your copy.  
  Key access:  

- **Limits**  
  Displays all limits files for your copy.  
  Key access:  

**Sort**  
Sorts the files according to a file attribute for your copy, including **By Date**, **By Name** and **Order Up Down**. **Order (Up)** displays files in ascending order. **Order (Down)** displays files in descending order.  
Key access:  

---
Frequency

Press [Frequency] activates the center frequency function, and accesses the menu of frequency functions. The center frequency, or start and stop frequency values appear below the graticule on the display.

When changing both the center frequency and span, change the frequency first since the frequency value can limit the span.

**NOTE**

When changing both the center frequency and span, change the frequency first since the frequency value can limit the span.

<table>
<thead>
<tr>
<th>Key Access</th>
<th>Function Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Center Freq</strong></td>
<td>Activates the center frequency function and sets the horizontal center of the display to a specific frequency.</td>
</tr>
<tr>
<td>[Frequency]</td>
<td></td>
</tr>
<tr>
<td><strong>Start Freq</strong></td>
<td>Sets the frequency at the left side of the graticule. The left and right sides of the graticule correspond to the start and stop frequencies.</td>
</tr>
<tr>
<td>[Frequency]</td>
<td></td>
</tr>
<tr>
<td><strong>Stop Freq</strong></td>
<td>Sets the frequency at the right side of the graticule. The left and right sides of the graticule correspond to the start and stop frequencies.</td>
</tr>
<tr>
<td>[Frequency]</td>
<td></td>
</tr>
<tr>
<td><strong>CF Step</strong></td>
<td>Changes the step size for the center frequency function. On selecting a step size and activating the center frequency function, the arrow keys change center the frequency by the step-size value. The step size function is useful for finding harmonics and sidebands beyond the current frequency span of the analyzer. Selecting auto-couple sets the center frequency step size to one division (10 percent of the span).</td>
</tr>
<tr>
<td>[Frequency]</td>
<td></td>
</tr>
</tbody>
</table>
Signal Track
On Off

Moves the signal that is nearest to the active marker to the center of the display and keeps the signal there. “ST” appears in the lower-left corner of the display.

Pressing Signal Track (Off); Preset (Preset Type set to Factory); or Marker > All Off turns off the signal track function.

Setting signal track on and reducing the span initiates an automatic zoom and reduces the span in steps, so that the signal remains at the center of the display. If the span is zero, signal track cannot be activated.

Key access: Frequency

NOTE

If no marker is active, pressing Signal Track (On) activates a marker, perform a peak search, and center the marker on the display. Switching to zero span sets Signal Track (Off).
Marker

Accesses the marker control softkeys that select the type and number of markers. Markers are diamond-shaped characters that identify points of traces. Up to twelve pairs of markers may appear on the display simultaneously; only one pair can be controlled at a time.

Select Marker

Selects one of the twelve possible markers. A marker that has already been selected will become active. If a marker has been turned on and assigned to a specific trace, it will be active on that trace when selected.

Key access: 

Normal

Activates a single frequency marker at the center of the active trace if a marker is not already displayed.

Displaying a marker before enabling the Normal function enables the marker at the position of the selected marker. The marker number shows above the marker. The knob and/or arrow keys move the marker left or right. Entering a value from the numeric keypad moves the marker to the trace point nearest to that value. Annotation in the active function block and in the upper-right corner indicates the frequency and amplitude of the marker (time and amplitude, if in zero span.) Pressing Normal turns off the Delta function and moves the active marker to the delta marker position.

Key access: 

Delta

Accesses the submenu to use the marker delta function.

Key access: 

Delta (On) activates a second marker at the position of the first marker. If no marker is present, two markers appear at the center of the display. The amplitude and frequency (or time) of the first marker is fixed. The marker number is indicated above the delta marker, and the same number is indicated with an R (for example, 1R) above the reference marker.
Use the data control keys to position the delta marker. Annotation in the active function block and in the upper-right corner indicates the frequency/time and amplitude differences between the two markers. **Delta (Off)** moves the reference marker to the active marker position, allowing you to make delta measurement from differing reference points without having to turn off the markers and begin again.

**Key access:**  

**Ref Delta**  

**Toggles the Delta Pair** between the reference (start) and delta (stop) markers. The start marker number is indicated with a number and an R above the marker (for example, 1R) and the delta marker is indicated with a marker number.

**Key access:**  

**Span Pair**  

**Toggles the Span Pair** function between the span and center markers. The start marker number is indicated with a number and an R above the marker (such as 1R) and the stop marker is indicated with a marker number. Adjusting the span changes the frequency difference between the two markers while maintaining the midpoint between the two markers at a fixed frequency. Changing the center changes the center point between the two markers while maintaining the frequency difference.

**Key access:**  

**NOTE**  

Ref and Delta markers maintain their displayed x-axis location, but not their frequency values when you change a parameter that redefines the x-axis scale. Reset these markers when parameters such as Span or Center Freq are changed.

**Off**  

**Turns off the selected marker by the Select Marker key.** **Off** also turns off the related functions such as signal track. It also removes marker annotation from the display.

**Key access:**  

**Marker**
4  Key Reference

**All Off**  Turns off all of the markers, including markers used for signal track. This also removes marker annotation.  
Key access:  Marker

**Function**  Accesses the marker function softkeys listed below.  
Key access:  Marker

**Freq Counter**  Accesses the frequency counter function.  
Key access:  Marker > Function

- **Freq Counter On Off**  Toggles the frequency counter function between on and off.  
  Key access:  Marker > Function > Freq Count

- **Resolution Auto Man**  Toggles the frequency counter resolution between manual and auto-couple. The allowed values are 0.1, 1, 10, 100 Hz and 1 kHz. Pressing Auto auto-couples this resolution to the span.  
  Key access:  Marker > Function > Freq Count

**NOTE**  The ratio of the resolution bandwidth to span must be greater than 0.02 for the frequency counter to work properly. Frequency counter properly only on CW signals or discrete peaks. For a valid reading, the marker must be >40 dB above the noise.

**Phase Noise**  Accesses the phase noise function softkeys.  
Key access:  Marker > Function

- **Phase Noise On Off**  Toggles the phase noise function between on and off.  
  Key access:  Marker > Function > Phase Noise

- **Offset Manual**  Sets the offset of marker manually to measure phase noise.  
  Key access:  Marker > Function > Phase Noise

- **Offset**  Sets the offset to ±1, ±10, ±20, ±30, ±50, ±100 kHz or ±1 MHz.  
  Key access:  Marker > Function > Phase Noise
For more details on how to measure the phase noise of a signal, please refer to “Measuring Phase Noise” on page 51.

**Optimize Phase Noise**

This softkey is valid only when span fall in the range of 100 Hz and 100 kHz. Once enable this softkey, 1st LO Loop filter bandwidth will be changed from 5 kHz or so to 120-150 kHz automatically, which optimizes the phase noise close in to the carrier.

Key access: `Marker > Function > Phase Noise`

**NOTE**

Optimize Phase noise (On) will worsen phase noise far away from the carrier. If you pay more attention to phase noise far away from the carrier, select Optimize Phase noise (Off).

**Marker Trace**

Activates a marker on the trace if there are no markers turned on. If a marker is currently active, press Marker Trace until 1, 2, 3, or 4 is underlined: the active marker moves to the selected trace.

Selecting Auto mode moves the marker to the automatically selected trace. The trace selection is to look for the lowest numbered trace in the following mode order: Clear-write, Max-hold, Min-hold and View. If there are no traces in any of these modes, it selects trace 1.

Key access: `Marker > More`

**Marker Table**

Compresses the graticule and displays marker information in a table. The information includes the marker number, trace number, marker type, X axis value, and the amplitude.

Key access: `Marker > More`

**On**

Activates/deactivates the marker table.

Key access: `Marker > More > Marker Table`

**Off**

**Prev Page**

Displays the previous/next page of the marker table.

Key access: `Marker > More > Marker Table`
Marker->

Press \texttt{Marker} accesses the following marker function softkeys:

\textbf{Mkr \textarrow{CF}}

Sets the frequency of the marker to the center frequency. In delta mode, \texttt{Mkr \textarrow{CF}} sets the center frequency to the marker delta value. \texttt{Mkr \textarrow{CF}} is not available in zero span.

Key access: \texttt{Marker}

\textbf{Mkr \textarrow{CF Step}}

Changes the center-frequency step size to match the value of the active marker. Press \texttt{Frequency \textarrow{> CF Step}} to view the step size. The step size is the frequency difference between the markers when marker delta is active. Use this function to step from one signal harmonic to another. \texttt{Mkr \textarrow{CF Step}} is not available in zero span.

Key access: \texttt{Marker}

\textbf{Mkr \textarrow{Start}}

Changes the start frequency so that it is equal to the frequency of the active marker. In delta mode, \texttt{Mkr \textarrow{Start}} sets the start frequency to the marker delta value. \texttt{Mkr \textarrow{Start}} is not available in zero span.

Key access: \texttt{Marker}

\textbf{Mkr \textarrow{Stop}}

Changes the stop frequency so that it is equal to the frequency of the active marker. In Delta mode, \texttt{Mkr \textarrow{Stop}} sets the stop frequency to the marker delta value. \texttt{Mkr \textarrow{Stop}} is not available in zero span.

Key access: \texttt{Marker}

\textbf{Mkr \textarrow{Ref LeL}}

Changes the reference level to the active marker value, moving the marked point to the reference level (top line of the graticule). In delta mode, \texttt{Mkr \textarrow{Ref LeL}} sets the reference level to the amplitude difference between the markers. (For example, if the difference is \(-15\) dB, the reference level \(-15\) dBm.)

Key access: \texttt{Marker}
Meas

In the **Spectrum Analyer** mode (see **MODE**), **Meas** key displays a menu for measurements such as adjacent channel power, occupied bandwidth, channel power, spectrum emission mask and TOI. Refer to Chapter 5, “One-Button Measurements” for more information about these measurements. Press **Measure Off** to turn the measurement off.
**MODE**

Selects the measurement mode of your analyzer.

**Spectrum Analyzer** mode is the default mode and is for general purpose measurement use. Additional measurement modes can be added.

**Spectrum Analyzer**

Selects the spectrum analysis measurement mode for your analyzer.

Key access: MODE

**Tracking Generator**

Accesses the tracking generator functions. (Option TG3)

Key access: MODE
Peak Search

Places a marker on the highest peak based on the settings of the "Search Criteria" on page 88. Refer to "Peak Search Type" on page 89, for more information on the effect of settings.

**NOTE**

All peak search functions ignore the LO feed through. The process for determining if the Peak is the LO feed through takes into account Start Frequency, Span, Resolution Bandwidth, Resolution Bandwidth shape factor, and Frequency Accuracy. If there is no point of inflection within the LO feed through range, the point on the trace with maximum amplitude, that is higher in frequency than the LO feed through, will be selected.

- **Peak Search**
  Performs peak search as described above.
  Key access: [Peak Search]

- **Next Peak**
  Places the marker on the next highest peak. The signal peak must exceed the peak threshold value by the peak excursion value. If there is no peak, the marker will not move.
  Key access: [Peak Search]

- **Next Pk Right**
  Moves the marker to the next peak to the right of the current marker. The signal peak must exceed the peak threshold value by the peak excursion value. If there is no peak to the right, the marker will not move and the "No Peak Found" error message will appear on the display.
  Key access: [Peak Search]

- **Next Pk Left**
  Moves the marker to the next peak to the left of the current marker. The signal peak must exceed the peak threshold value by the peak excursion value. If there is no peak to the left, the marker will not move and the "No Peak Found" error message will appear on the display.
  Key access: [Peak Search]

- **Min Search**
  Moves the active marker to the minimum detected amplitude.
  Key access: [Peak Search]
**Pk-Pk Search**
Finds and displays the frequency (or time, if in zero span) and amplitude differences between the highest and lowest trace points.

Key access: 

**Continuous Pk On Off**
When a marker is placed on a signal and **Continuous Pk** is on, the marker will remain on the signal even if the frequency changes, as long as the amplitude of the signal does not change by more than 3 dB from one sweep to another.

If the signal is lost, the marker will attempt to find it again and maintain on the peak. If there are other signals on screen near the same amplitude, one of them may be found instead. Signals near 0 Hz cannot be maintained effectively.

This function is intended to maintain the marker on signals with a frequency that is changing, and an amplitude that is not changing.

Key access: 

**N dB Points On Off**
Activates the N dB function. Pressing **N dB Points (On)** activates two arrows that are N dB down from the marker. The frequency difference between the two arrows will be displayed in the upper right-hand corner of the display.

Key access: 

**Search Criteria**
Accesses the submenu to set the criteria for peak search.

Key access: 

**Peak Excursion**
Sets the minimum amplitude variation of signals that the marker identifies as a peak. If a value of 10 dB is selected, the marker moves only to peaks that rise and fall more than 10 dB above the peak threshold value. When the peak excursion is 6 dB of higher,

---

**NOTE**
Two signal peaks, which are so close together that the amplitude drop between them is less than the peak-excursion value, are not recognized as two peaks. A signal peak is recognized only if it has a peak excursion drop above the noise floor, on both sides of the signal.
the marker-peak do not recognize signals less than peak-excursion value above the noise floor. To correct this, when measuring signals near the noise floor, reduce the excursion value. To prevent the marker from identifying noise as signals, reduce the noise floor variance less than the peak-excursion value by reducing the video bandwidth or by using video averaging.

Key access: > More > Search Criteria

**Peak Threshold**
Sets the minimum amplitude that the marker can identify as a peak. For example, if set to –90 dBm, the marker moves only to peaks that rise and fall more than the peak excursion above –90 dBm.

Key access: > More > Search Criteria

**Threshold**
Hides the threshold line.

Key access: > More > Search Criteria

**Peak Search Type**
Selects the peak search mode.

Key access: > More > Search Criteria

**Max Value**
A Peak search with Max Value type places a marker on the highest peak, excluding the LO feedthrough peak.

Key access: > More > Search Criteria > Peak Search Type

**Excursion & Threshold**
When Peak Search Type is Excursion & Threshold, a peak search places a marker on a peak that meets the Peak Excursion and Peak Threshold parameters. If Peak Search Type is Excursion & Threshold and no peak satisfies the selected parameters, a marker is placed at the center of the trace, and the error message, “No Peak Found” will appear.

Key access: > More > Search Criteria > Peak Search Type
**Peak Table**

Accesses the following **Peak Table** softkeys to set a peak table.

Key access: [Peak Search] > More

**Peak Table On Off**

Displays a list of up to 12 signal peaks that is updated at the end of each sweep. The peak table function works with trace 1 only.

Key access: [Peak Search] > More > Peak Table

**Peak Sort Freq Amptd**

Switches the peak table sorting routine between listing the peaks in order by descending amplitude or frequency.

Key access: [Peak Search] > More > Peak Table
Preset/System

Accesses the Preset and System softkeys. When the analyzer is in the remote mode, pressing \( \text{Preset/System} \) returns the analyzer to the local mode and enables front-panel control.

Preset

Provides a known state of the instrument for making measurements. The analyzer allows you to select whether a user preset, or factory preset is performed.

If \textbf{Preset Type} is set to \textbf{Factory}, pressing \( \text{Preset/System} \) > \textbf{Preset} performs a factory preset, which performs the following:

- Resets the analyzer to Spectrum Analyzer (SA) mode
- Brings up the \textbf{Frequency} menu
- Sets certain conditions to their default values
- Clears both the input and output buffers and clears all trace data
- Sets the amplitude values of trace 2, 3 and 4 to the bottom of the screen
- Turn amplitude-correction factors off, but remain in analyzer memory
- Turn limit line testing off, but the limit line tables remain in analyzer memory

See Table \textbf{Factory Preset States} as follows for the conditions established by performing a factory preset.

When \textbf{Preset Type} is set to \textbf{User}, pressing \( \text{Preset/System} \) > \textbf{Preset} displays the softkeys \textbf{User Preset} and \textbf{Factory Preset}, you then select the specific preset as you need.

Key access: \( \text{Preset/System} \)
### Factory Preset State

<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attenuation</td>
<td>20 dB(Auto)</td>
</tr>
<tr>
<td>Center frequency</td>
<td>1.5 GHz</td>
</tr>
<tr>
<td>CF step size</td>
<td>300 MHz</td>
</tr>
<tr>
<td>Start Frequency</td>
<td>0 Hz</td>
</tr>
<tr>
<td>Stop Frequency</td>
<td>3 GHz</td>
</tr>
<tr>
<td>Signal Track</td>
<td>Off</td>
</tr>
<tr>
<td>Span</td>
<td>3 GHz</td>
</tr>
<tr>
<td>Reference level</td>
<td>0 dBm</td>
</tr>
<tr>
<td>Log scale/Division</td>
<td>10 dB</td>
</tr>
<tr>
<td>Int Preamp</td>
<td>Off</td>
</tr>
<tr>
<td>Trace 1</td>
<td>Clear Write</td>
</tr>
<tr>
<td>Trace 2, 3, 4</td>
<td>Blank</td>
</tr>
<tr>
<td>Sweep Time</td>
<td>100.2 ms(Auto)</td>
</tr>
<tr>
<td>Sweep</td>
<td>Continuous</td>
</tr>
<tr>
<td>Limit</td>
<td>Off</td>
</tr>
<tr>
<td>Limit line testing</td>
<td>Off</td>
</tr>
<tr>
<td>Limit point</td>
<td>0</td>
</tr>
<tr>
<td>Detector</td>
<td>Peak(Auto)</td>
</tr>
<tr>
<td>Display line</td>
<td>-25 dBm(Off)</td>
</tr>
<tr>
<td>Video bandwidth</td>
<td>3 MHz(Auto)</td>
</tr>
<tr>
<td>VBW/RBW ratio</td>
<td>1.000 (Auto)</td>
</tr>
<tr>
<td>Resolution bandwidth</td>
<td>3 MHz(Auto)</td>
</tr>
</tbody>
</table>

### Additional Values

- Average Type: Video (Auto)
- Averaging: 1(Off)
- Peak Excursion: 6 dB
- Peak Threshold: -90 dBm
- Peak Search Type: Max Value
- Peak Table: Off
- Peak Sort: Amplitude
- Delta Pair: Delta
- Span Pair: Center
- Trigger: Free Run
- Markers: Normal(Off)
- Marker Delta: Off
- Marker Table: Off
- Measure: Meas Off
- File Catalog: Local
- File Type: State
- File Sort: By Date
- Optimize phase noise: Off
- Frequency Counter: Off
- Frequency counter resolution: 1 kHz(Auto)
**Pwr on/Preset**

Accesses the following softkeys for the preset settings.

Key access:

**Power on**

Determines the state of the analyzer when the analyzer is turned on. **Power On** set to **Preset** recalls the analyzer settings previously with the **Preset** function. **Power On** set to **Last** recalls the analyzer settings when previously power off.

Key access: > Pwr on/Preset

**Last Preset**

Determines the state of the analyzer when the analyzer is turned on. **Power On** set to **Preset** recalls the analyzer settings previously with the **Preset** function. **Power On** set to **Last** recalls the analyzer settings when previously power off.

Key access: > Pwr on/Preset

**Preset Type**

Selects **User** or **Factory** preset settings.

Key access: > Pwr on/Preset

**User**

Pressing **Preset** recalls the analyzer settings defined by **Save User Preset**.

Key access: > Pwr on/Preset > Preset Type

**Factory**

Pressing **Preset** recalls the analyzer settings originally set at the factory.

Key access: > Pwr on/Preset > Preset Type

**Save User Preset**

Saves the active settings of the analyzer into the User Preset register. To recall these settings, select **Preset Type** to **User**.

Key access: > Pwr on/Preset

**Alignment**

Accesses the following softkeys that align the internal circuitry of the analyzer, load default values for the alignment system, and adjust the 10 MHz reference.

Key access:

**Align**

Accesses the **Align** softkeys.

Key access: > Alignment

**All (Ext Cable)**

Initiates the alignment of systems with a cable connected from the **CAL OUT** to **RF IN** (Except option TG3).

Key access: > Alignment > Align
Language  
Accesses the softkeys for selecting the screen menu language. 
Key access:  

Diagnostics  
Accesses the Front Panel Test softkey to verify the functionality of each front-panel key. The number next to each key name increments once each time the key is pressed. Rotating the knobs causes the number of pulses to be counted. Press Return will go back to the main menu. 
Key access:  

Show System  
Displays the number and description of the options installed in your analyzer. It also displays the instrument model number, product number, serial number, the date of production, etc. 
Key access:  

Show Hardware  
Provides detailed information about the hardware installed on your analyzer, including the model number and firmware revision. 
Key access:  

Show Software  
Provides detailed information about the software installed on your analyzer. 
Key access:  

CAL OUT  
On Off  
Turns the internal amplitude reference signal on or off. When this signal is on, the RF input is disabled. 
Key access:  

Timebase  
verifies the settability of the 10 MHz reference and to adjust for changed operating conditions, such as temperature. 
Key access:  

Load Default  
Loads the default values for the alignment system, turns on the frequency corrections, and resets the timebase to the factory values. 
Key access:  

**Show Errors**
Accesses a list of the last 100 errors reported. The most recent error will appear at the bottom of the list. The first error listed will be removed firstly if the error list is longer than 20 entries. If the same error occurs continuously, the same error message will not be added to the list. Refer to “Instrument Messages” on page 119 for details.

Key access: `Preset System` > More

**Prev Page/Next Page**
Access the previous/next page of error messages.

Key access: `Preset System` > More > Show Errors

**Clear Error Queue**
Clears all the errors in the errors queue.

Key access: `Preset System` > More > Show Errors

**Time/Date**
Accesses the following Time/Date menu keys used to set and display the real-time clock:

Key access: `Preset System` > More

**Time/Date On Off**
Toggles the time/date display between on and off.

Key access: `Preset System` > More > Time/Date

**Date Format**
Changes the display format of date from month-day-year to day-month-year.

Key access: `Preset System` > More > Time/Date

**Set Time**
Sets the time of the real-time clock. Enter the time in 24 hour HHMMSS format. Valid hour (HH) values are from 00 to 23. Valid minute (MM) and second (SS) values are from 00 to 59.

Key access: `Preset System` > More > Time/Date

**Set Date**
Sets the date of the real-time clock. Enter the date in the YYYYMMDD format. Valid year (YYYY) values are 0000 through 9999. Valid month (MM) values are from 01 to 12, and valid day values are from 01 to 31.

Key access: `Preset System` > More > Time/Date
4 Key Reference

**Licensing** Accesses the security system to enable licensing for individual options. There is no way to turn off an option through this system. Once an option has been licensed for a given analyzer, it cannot be transferred to a different analyzer.

Key access:  > More > More

**Option** Allows you to key in a three-character option number. The option number will appear on the second line of the Option key.

Key access:  > More > More > Licensing

**License Key** Allows you to key in a license key number. The license key number appears on the second line of the License Key softkey.

Key access:  > More > More > Licensing

**Activate License** Activates the option whose number you previously keyed in License Key. If your entry is correct, the option will be enabled and the message: “Option activated” will appear in the status line of your display. The option number and license key numbers will also clear from the License Key and Option key.

If your entry is incorrect, the error message “License key invalid” appears in the status line of the display. Edit the option number and license key number until they are correct.

Key access:  > More > More > Licensing

**Brightness** Adjusts the brightness of the display from 1% to 100%.

Key access:  > More > More
**SPAN**

Activates the span function and accesses the submenu of span functions. Pressing the **SPAN** function changes the frequency range symmetrically about the center frequency. The frequency-span readout describes the total displayed frequency range. To determine frequency span per horizontal graticule division (when the frequency scale type is set to linear), divide the frequency span by 10.

**Span**

Enters a span frequency range value.

Key access: **SPAN**

**Full Span**

Changes the span to full span showing the full frequency range of the analyzer. Full span sets **Signal Track, Marker** function off.

Key access: **SPAN**

**Zero Span**

Changes the frequency span to zero. In this mode, the current center frequency is displayed in the time domain (the x-axis is displayed in units of time), like a conventional oscilloscope. Zero span sets **Signal Track (Off)**.

Key access: **SPAN**

**Last Span**

Changes the span to the previous span setting.

Key access: **SPAN**
Accesses the following softkeys to provide selection of the sweep mode and trigger mode of the analyzer:

Selects the length of time the analyzer takes to tune across the displayed frequency span (or, in zero span, the time the analyzer takes to sweep the full screen). Reducing the sweep time increases the sweep rate. Change the sweep time by using the arrow keys, the knob, or the numeric keypad.

In non-zero spans:

When the sweep time is auto-coupled, the analyzer selects the optimum (shortest) sweep time for the current settings. This selection process is influenced by several factors:

- The maximum tuning rate of the spectrum analyzer
- The selected resolution and video bandwidth filters
- The maximum sample rate of the analog-to-digital converter
- The number of trace points
- The amplitude scale (logarithmic or linear)
- The detector mode

You may select a sweep time less than the auto-coupled value; however this may generate measurement errors. The minimum sweep time is 50 ms.

In zero span:

The minimum sweep time is determined by the maximum sample rate of the ADC and the number of sweep points. The minimum sweep time is 2 microseconds. The maximum sweep time is 4000 seconds.

Key access: Sweep Single

Pressing **Sweep Single** puts the analyzer in single-sweep mode. Press **Sweep Single** to initiate a sweep when in single-sweep mode.

Key access: Sweep Single
Sweep Cont  Selecting **Sweep Cont** causes one sweep to follow another as soon as it is triggered. Pressing **Preset** (When **Preset Type** is set to **Factory**) or turning the power on, sets the sweep mode to continuous sweep.

Key access: Sweep/Trig

Free Run  New sweep starts as soon as possible after the current sweep ends.

Key access: Sweep/Trig > More

Video  Activates the trigger condition that starts the next sweep if the detected RF envelope voltage rises to a level set by the video trigger level. When **Video** is pressed, a line appears on the display. The analyzer triggers when the input signal exceeds the trigger level at the left edge of the display. Change the trigger level by using the arrow keys, the knob, or the numeric keypad.

Key access: Sweep/Trig > More

**NOTE**  This function is not available when the Resolution Bandwidth is less than 1 kHz. Selecting a Resolution Bandwidth less than 1 kHz while in Video Trigger mode, changes the Trigger mode to Free Run.

External Pos  Activates the trigger condition that start the next sweep when the external voltage (connected to **EXT TRG IN** on the rear panel) passes through approximately 2 volts. The external trigger signal must be a 0 V to +5 V TTL signal. Set the trigger polarity to positive.

Key access: Sweep/Trig > More

External Neg  Sets the trigger polarity to negative.

Key access: Sweep/Trig > More
View/Trace

Accesses the trace keys to store and manipulate trace information. Each trace consists of a series of points in which amplitude data is stored. The analyzer updates the information for any active trace with each sweep.

**Select Trace**
- Selects the trace for current use.
- Key access: View

**Clear Write**
- Erases any data previously stored in the selected trace, then continuously displays any signals during each sweep of the analyzer. This function is activated for trace 1 at power-on and **Factory Preset**.
- Key access: View

**Max Hold**
- Retains the maximum level for each trace point of the selected trace, and updates each trace point if a new maximum level is detected in successive sweeps.
- Key access: View

**Min Hold**
- Retains the minimum level for each trace point of the selected trace, and updates each minimum trace point if a new minimum level is detected in following sweeps.
- Key access: View

**View**
- Holds and displays the amplitude data of the selected trace. The trace register is not updated as the analyzer sweeps. Press View to retrieve a stored trace previously deactivated by pressing Blank.
- Key access: View

**Blank**
- Stores the amplitude data for the selected trace, then removes the trace from the display. The selected trace register no longer updates as the analyzer sweeps. To activate this function for traces 2, 3 and 4 at power-on press **Preset** (when **Preset Type** is set to **Factory**).
- Key access: View
5
One-Button Measurements

Channel Power 102
Occupied BW 104
ACP 107
Intermod (TOI) 110
Spectrum Emission Mask 112

This chapter provides you with functional descriptions of all available measurements when you press the front-panel hardkey (Spectrum Analyser is selected).

We assume that you understand the front and rear panel layout, and display annotations of the analyzer. If you do not, please refer to “Agilent N9320A at a Glance” on page 2.
Channel Power

Channel Power measures the power and power spectral density in the specified channel bandwidth. One white frame on the display indicates the edges of the channel bandwidth. You need to set the center frequency, reference level, and channel bandwidth.

The power calculation method used to determine the channel power is a traditional method known as the integration bandwidth (IBW) method. A swept spectrum is used as the basis for this calculation. Therefore, it is important to set the resolution bandwidth correctly before making this measurement using the following formula:

\[ RBW = \frac{k(span)}{n} \]

Where \( k \) is a value between 1.2 and 4.0 and \( n=461 \) is the number of trace points.

**Figure 21  Channel Power Measurement**
**Avg Number**

Specifies the number of measurement averages used when calculating the measurement result with **Avg Number (On)**. The range of the number is from 1 to 1000. Use the knob, the arrow keys or the numeric keypad to set the number. The average will be displayed at the end of each sweep. Selecting **Off** disables measurement averaging.

Key access: **Meas > Channel Power**

**Avg Mode**

Toggles the average mode between **Exp** or **Repeat**. This determines the averaging action after the specified number of measurements (average count) is reached.

When you select **Exp**, each successive data acquisition after the average count is reached is exponentially weighted and combined with the existing average. Exponential averaging weights new data more than old data, which facilitates tracking of slow-changing signals. The average will be displayed at the end of each sweep.

If you select **Repeat**, after reaching the average count, all previous data is cleared and the average count is back to 1.

Key access: **Meas > Channel Power**

**Integ BW**

Specifies the range of integration used in calculating the power in a channel. For example, set the main (center) channel bandwidth. Note that the white frame indicates the integration bandwidth. Be sure the span is set between 1 and 10 times the integration bandwidth. Change integration bandwidth by using the knob and the arrow keys.

Key access: **Meas > Channel Power**

**Chan Pwr Span**

Sets the analyzer span for the channel power measurement by using the knob and the arrow keys. Be sure the span is set between 1 and 10 times the integration bandwidth.

Key access: **Meas > Channel Power**
Occupied BW

Occupied Bandwidth integrates the power of the displayed spectrum. The power-bandwidth routine first computes the power of all signal contained in the trace, then calculates the span which contains the power of a selected percentage. The percentage value defaults to 99% of the occupied bandwidth power.

For 99% occupied power bandwidth, Markers are placed at the frequencies on either side of 99% of the power. 1% of the power is evenly distributed outside the markers. The difference between the marker frequencies is the 99% power bandwidth.

This is the main menu of occupied bandwidth measurement including all related parameters and measurement results.

Figure 22  Occupied Bandwidth Measurement

The occupied bandwidth function also indicates the difference between the analyzer center frequency and the center frequency of the channel. This “Transmit Freq Error”
One-Button Measurements

is defined as the difference between the \((f_1 + f_2)/2\) and the tuned center frequency of the signal.

**NOTE**

To get the right measurement result, you need to set the center frequency, reference level, and channel spacing first.

<table>
<thead>
<tr>
<th>Avg Number On Off</th>
<th>Select On to specify the number of measurement averages used when calculating the measurement result. The average is displayed at the end of each sweep. Select Off to disable measurement averaging. The range is from 1 to 1000. Key access: [Meas] &gt; [Occupied BW]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg Mode Exp Repeat</td>
<td>Toggles the termination control type used for the averaging function between Exp and Repeat. This determines the averaging action after the specified number of measurements (average count) is reached. When you select Exp, each successive data acquisition after the average count is reached is exponentially weighted and combined with the existing average. Exponential averaging weights new data more than old data, which facilitates tracking of slow-changing signals. The average is displayed at the end of each sweep. When you select Repeat, after reaching the average count, all previous data is cleared and the average count is back to 1. Key access: [Meas] &gt; [Occupied BW]</td>
</tr>
<tr>
<td>Max Hold On Off</td>
<td>Toggles the maximum hold trace feature between On and Off. Maximum hold displays and holds the maximum responses of a signal. Key access: [Meas] &gt; [Occupied BW]</td>
</tr>
<tr>
<td>Occ BW% Pwr</td>
<td>Edits the percentage of signal power used when determining the occupied bandwidth. Key access: [Meas] &gt; [Occupied BW]</td>
</tr>
</tbody>
</table>
**OBW Span**

Specifies the range of integration used in calculating the total power from which the percent occupied bandwidth is then calculated. The analyzer span will be set to the same value as the OBW Span for the measurement. OBW Span should be set to approximately 2 times the expected occupied bandwidth result. The range is from 100 Hz to 3 GHz.

Key access: **Meas** > **Occupied BW**

**x dB**

Specifies the power level used to determine the emission bandwidth as the number of dB down from the highest signal point, within the occupied bandwidth span. This function is an independent calculation from the OBW calculation. The x dB Bandwidth result is also called the emissions bandwidth, or EBW. This will set two arrows to your specified dB value below the maximum power and compute the total power between the arrows. Frequencies f1 and f2 are determined as the furthest frequencies x dB below and above summit, respectively. The emission bandwidth is then calculated as f2 – f1 as shown by the arrows indicated in Figure 22 (note that the diamond markers are for the OBW function). The range is from –100.0 to –0.1 dB.

Key access: **Meas** > **Occupied BW**

**NOTE**

The asterisk next to the x dB bandwidth value in Figure 22 indicates the results may not have been determined with optimal analyzer settings. If emission bandwidth is your primary interest, select **Max Hold**. Then change detector mode to peak by pressing **Det/Display** > **Detector** > **Positive Peak**. Acquiring peak data ensures accuracy of this measurement.
ACP

Adjacent Channel Power (ACP) measures the power present in adjacent transmit channels. The span is automatically set according to the six available offsets and their associated integration bandwidths defined by you.

**Figure 23  Adjacent Channel Power Measurement**

Pressing **On** specifies the number of measurements that will be averaged when calculating the measurement result. The average will be displayed at the end of each sweep. Pressing **Off** disables the measurement averaging.

Key access: **Meas > ACP**

**Avg Mode**

Enables you to select the type of termination control used for the averaging function (**Exp** or **Repeat**). This determines the averaging action after the specified number of measurements (average count) is reached.

When you select **Exp**, each successive data acquisition after the average count is reached is exponentially weighted and combined with the existing average. Exponential averaging
One-Button Measurements

weights new data more than old data, which facilitates tracking of slow-changing signals. The average is displayed at the end of each sweep.

When you select Repeat, after reaching the average count, all previous data is cleared and the average count is back to 1.

Key access: Meas > ACP

**Chan Integ BW**
Specifies the range of integration used in calculating the power in the main channel. Use the knob and the arrow keys to set the bandwidth.

Key access: Meas > ACP

**Offset/Limits**
Accesses softkeys that allow you to configure the offsets for the ACP measurement.

Key access: Meas > ACP

- **Offset**
  - A B C D E F
  - Selects the offset the softkeys will affect. Press Offset until the letter of the desired offset is underlined.
  - Key access: Meas > ACP > Offset/Limits

- **Offset Freq**
  - On Off
  - Sets the frequency difference from the center of the main channel to the center of the offset for a maximum of 6 offsets (labeled A-F). It also allows you to turn On/Off the offsets that you want to measure.
  - Key access: Meas > ACP > Offset/Limits

- **Ref BW**
  - Sets the reference bandwidth (integration bandwidth) for each offset.
  - Key access: Meas > ACP > Offset/Limits

- **Pos Offset Limit**
  - Sets the upper limit for the upper segment of the specified offset pair.
  - Key access: Meas > ACP > Offset/Limits

- **Neg Offset Limit**
  - Sets the upper limit for the lower segment of the specified offset pair.
  - Key access: Meas > ACP > Offset/Limits

N9320A Spectrum Analyzer
One-Button Measurements

**Meas Type**
Specify the reference for the measurement, either **Total Pwr Ref** or **PSD Ref**. Relative values are displayed referenced to either the total power (**Total Pwr Ref**) or the power spectral density (**PSD Ref**) measured in the main channel.

**Method**
Enables you to select the measurement method. The resolution bandwidth (**RBW**) method is most useful for measuring cdmaOne signals; the integration bandwidth method (**IBW**) is preferred for other signals.

**Total Pwr Ref**
Sets the adjacent channel power reference to automatic or manual when **Meas Type** is set to **Total Pwr Ref**. When select **Auto**, the carrier power result reflects the measured power value in the carrier. When set to **Man**, the last measured value is captured and held, or may be entered by the user. Relative values are displayed, referenced to the total power measured in the main channel.

**Limits**
Turns the testing of the limits on or off. When select **On**, each offset is compared to its upper and lower offset limit. In those cases where the power exceeds the limit, the calculated result will be displayed in red to indicate a failure. If there are any failures, the pass/fail indicator area show “FAIL” in red; if there are none, it shows “PASS” in green when using IBW method. Neither “FAIL” nor “PASS” will be displayed when using RBW method. Any offsets that are in the off state are not measured and their results will not be displayed on screen.

Key access:
- **Meas > ACP > More**
Intermod (TOI)

The third order intermodulation (TOI) measurement computes and displays the output intercept point (IP3), and places arrows upon the trace to indicate the measured signals and third-order products.

Figure 24  TOI Measurement

Set **Avg Number** to **On** to specify the number of measurement averages used when calculating the measurement result. The average will be displayed at the end of each sweep. Setting **Avg Number** to **Off** disables measurement averaging.

**Key access:**  > More> Intermod (TOI)

**Avg Mode**

Selects the type of termination control used for the averaging function (Exp/Repeat). This determines the averaging action after the specified number of measurements (average count) is reached.

When **Avg Mode** is **Exp**, Each successive data acquisition after the average count is reached is exponentially weighted and combined with the existing average. Exponential averaging weights new data more than old data, which facilitates tracking of slow-changing signals. The average is displayed at the end of each sweep.
When **Avg Mode** is **Repeat**, after reaching the average count, all previous data is cleared and the average count is back to 1.

Key access: Meas > More > Intermod (TOI)

**TOI Span**

Specifies the frequency span in which intermodulation products are measured. If you modify the value of span in the base instrument **Span** menu, the value in the **Intermod (TOI)** menu will be updated to reflect the new value, and the measurement will restart if it is running.

Key access: Meas > More > Intermod (TOI)

**Max Mixer Lvl**

Sets the relationship between the highest signal that can be displayed (the reference level) and the input attenuation. The relationship applies whenever the **Attenuation** is set to **Auto**.

The relationship is that the attenuation is given by reference level minus the max mixer level. For example, as the reference level changes, the input attenuator changes to ensure that a signal at the reference level does not exceed the **Max Mixer Lvl** setting.

When the TOI measurement is off, the previous maximum **Max Mixer Lvl** is restored.

Pressing **Auto** sets the maximum mixer level to –30 dBm.

Key access: Meas > More > Intermod (TOI)
Spectrum Emission Mask

Spectrum Emission Mask measurement includes the in-band and out-of-band spurious emissions. As it applies to W-CDMA (3GPP), this is the power contained in a specified frequency bandwidth at certain offsets relative to the total carrier power. It may also be expressed as a ratio of power spectral densities between the carrier and the specified offset frequency band. For WLAN, the reference power is taken as the peak PSD in the signal, and all offset results are also the peak PSD in that offset as opposed to the integrated power.

Figure 25  Spectrum Emission Mask

<table>
<thead>
<tr>
<th>Avg Number</th>
<th>On Off</th>
<th>Avg Number to On to specify the number of measurement averages used when calculating the measurement result. The average will be displayed at the end of each sweep. Setting Avg Number to Off disables measurement averaging. Key access:</th>
<th>Meas &gt; More &gt; Spectrum Emission Mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meas Type</td>
<td>Displays a menu where you can select a measurement reference type, Total Pwr Ref or PSD Ref. Key access:</td>
<td>Meas &gt; More &gt; Spectrum Emission Mask</td>
<td></td>
</tr>
</tbody>
</table>
**Ref Channel**

Accesses the softkeys that enable you to change the reference channel settings.

Key access: Meas > More > Spectrum Emission Mask > Meas Type

---

**Total Pwr Ref**

When **Total Pwr Ref** is selected, the power in the carrier is used as the reference in computing the relative power values for the offsets.

Key access: Meas > More > Spectrum Emission Mask > Meas Type

**PSD Ref**

When **PSD Ref** is selected, the mean power spectral density of the carrier is used in computing the relative power spectral density values for the offsets.

Key access: Meas > More > Spectrum Emission Mask > Meas Type

---

**Chan Integ BW**

Specifies the integration bandwidth used in calculating the power in the main channel.

Key access: Meas > More > Spectrum Emission Mask > Ref Channel

**Chan Span**

Specifies the span used in measuring the power in the main channel.

Key access: Meas > More > Spectrum Emission Mask > Ref Channel

**Sweep Time**

Specifies the sweep time used in measuring the power in the main channel.

Key access: Meas > More > Spectrum Emission Mask > Ref Channel

**Res BW**

Specifies the resolution bandwidth used in measuring and the power in the main channel.

Key access: Meas > More > Spectrum Emission Mask > Ref Channel
Displays the type of power measurement reference selected by **Meas Type**.

**Total Pwr Ref** is the power in the carrier that is used as the reference in computing the relative power values for the offsets. When **Man** is selected, this can be set by the user. When **Auto** is selected, this is the measured power in the reference carrier.

**PSD Ref** is the mean power spectral density in the carrier that is used as the reference in computing the relative power spectral density values for the offsets. When **Man** is selected, this can be set by the user, when **Auto** is selected, this is the measured mean power spectral density in the reference carrier.

Key access: **Meas > More > Spectrum Emission Mask > Ref Channel**

**Offset/Limits** Displays the menus where you can change the following parameters for offset frequency settings and pass/fail tests: **Offset, Start Freq, Stop Freq, Sweep Time, Res BW, and Limits**. Refer to the tables below for default settings of particular radio standards of interest.

Key access: **Meas > More > Spectrum Emission Mask**

### Table 1  Offsets & Limits Defaulted for W-CDMA (3GPP) Base Station Measurements

<table>
<thead>
<tr>
<th>Offset</th>
<th>Start Freq (MHz)</th>
<th>Stop Freq (MHz)</th>
<th>Res BW (kHz)</th>
<th>Abs Start (dBm)</th>
<th>Abs Stop (dBm)</th>
<th>Abs Couple</th>
<th>Rel Start (dBc)</th>
<th>Rel Stop (dBc)</th>
<th>Meas BW</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. On</td>
<td>2.515</td>
<td>2.715</td>
<td>30.00</td>
<td>-14.00</td>
<td>-14.00</td>
<td>Couple</td>
<td>-30.00</td>
<td>-30.00</td>
<td>1</td>
</tr>
<tr>
<td>B. On</td>
<td>2.715</td>
<td>3.515</td>
<td>30.00</td>
<td>-14.00</td>
<td>-26.00</td>
<td>Man</td>
<td>-30.00</td>
<td>-30.00</td>
<td>1</td>
</tr>
<tr>
<td>C. On</td>
<td>3.515</td>
<td>4.000</td>
<td>30.00</td>
<td>-26.00</td>
<td>-26.00</td>
<td>Couple</td>
<td>-30.00</td>
<td>-30.00</td>
<td>1</td>
</tr>
<tr>
<td>D. On</td>
<td>4.000</td>
<td>8.000</td>
<td>1000.00</td>
<td>-13.00</td>
<td>-13.00</td>
<td>Couple</td>
<td>-30.00</td>
<td>-30.00</td>
<td>1 33</td>
</tr>
<tr>
<td>E. On</td>
<td>8.000</td>
<td>12.500</td>
<td>1000.00</td>
<td>-13.00</td>
<td>-13.00</td>
<td>Couple</td>
<td>-30.00</td>
<td>-30.00</td>
<td>1</td>
</tr>
</tbody>
</table>

a. **Fail Mask** is set to **Absolute** and **Rel Stop** is set to **Couple**.
Table 2  Offsets & Limits Defaulted for W-CDMA (3GPP) Mobile Station Measurements

<table>
<thead>
<tr>
<th>Offset</th>
<th>Start Freq (MHz)</th>
<th>Stop Freq (MHz)</th>
<th>Res BW (kHz)</th>
<th>Abs Start (dBm)</th>
<th>Abs Stop (dBm)</th>
<th>Rel Couple</th>
<th>Rel Start (dBc)</th>
<th>Rel Stop (dBc)</th>
<th>Meas BW</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. On</td>
<td>2.515</td>
<td>3.485</td>
<td>30.00</td>
<td>-71.07</td>
<td>-71.07</td>
<td>Man</td>
<td>-35.23</td>
<td>-49.78</td>
<td>1</td>
</tr>
<tr>
<td>B. On</td>
<td>4.000</td>
<td>7.500</td>
<td>1000.0</td>
<td>-55.84</td>
<td>-55.84</td>
<td>Man</td>
<td>-35.50</td>
<td>-39.00</td>
<td>1</td>
</tr>
<tr>
<td>C. On</td>
<td>7.500</td>
<td>8.500</td>
<td>1000.0</td>
<td>-55.84</td>
<td>-55.84</td>
<td>Man</td>
<td>-39.00</td>
<td>-49.00</td>
<td>1</td>
</tr>
<tr>
<td>D. On</td>
<td>8.500</td>
<td>12.000</td>
<td>1000.0</td>
<td>-55.84</td>
<td>-55.84</td>
<td>Couple</td>
<td>-49.00</td>
<td>-49.00</td>
<td>1</td>
</tr>
<tr>
<td>E. Off</td>
<td>12.500</td>
<td>15.000</td>
<td>1000.0</td>
<td>-55.84</td>
<td>-55.84</td>
<td>Couple</td>
<td>-49.00</td>
<td>-49.00</td>
<td>1</td>
</tr>
</tbody>
</table>

a. Abs Stop is set to Couple and Fail Mask is set to Abs AND Rel.

Table 3  Offsets & Limits Defaulted for 802.11a and HiperLAN/2 Radio Standards

<table>
<thead>
<tr>
<th>Offset</th>
<th>Start Freq (MHz)</th>
<th>Stop Freq (MHz)</th>
<th>Abs Start (dBm)</th>
<th>Abs Stop (dBm)</th>
<th>Abs Couple</th>
<th>Rel Start (dBc)</th>
<th>Rel Stop (dBc)</th>
<th>Rel Couple</th>
<th>Meas BW</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. On</td>
<td>9.000</td>
<td>11.000</td>
<td>16.00</td>
<td>-4.00</td>
<td>Man</td>
<td>0.00</td>
<td>-20.00</td>
<td>Man</td>
<td>1</td>
</tr>
<tr>
<td>B. On</td>
<td>11.000</td>
<td>20.000</td>
<td>-4.00</td>
<td>-12.00</td>
<td>Man</td>
<td>-20.00</td>
<td>-28.00</td>
<td>Man</td>
<td>1</td>
</tr>
<tr>
<td>C. On</td>
<td>20.000</td>
<td>30.000</td>
<td>-12.00</td>
<td>-24.00</td>
<td>Man</td>
<td>-28.00</td>
<td>-40.00</td>
<td>Man</td>
<td>1</td>
</tr>
<tr>
<td>D. On</td>
<td>30.000</td>
<td>50.000</td>
<td>-24.00</td>
<td>-24.00</td>
<td>Couple</td>
<td>-40.00</td>
<td>-40.00</td>
<td>Couple</td>
<td>1</td>
</tr>
<tr>
<td>E. Off</td>
<td>50.000</td>
<td>100.000</td>
<td>-24.00</td>
<td>-24.00</td>
<td>Couple</td>
<td>-40.00</td>
<td>-40.00</td>
<td>Couple</td>
<td>1</td>
</tr>
</tbody>
</table>

a. Res BW is set to 100 kHz and Fail Mask is set to Rel.
5 One-Button Measurements

Table 4 Offsets & Limits Defaulted for 802.11b Radio Standarda

<table>
<thead>
<tr>
<th>Offset</th>
<th>Start Freq (MHz)</th>
<th>Stop Freq (MHz)</th>
<th>Abs Start (dBm)</th>
<th>Abs Stop (dBm)</th>
<th>Rel Start (dBc)</th>
<th>Rel Stop (dBc)</th>
<th>Meas BW</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. On</td>
<td>11.00</td>
<td>22.00</td>
<td>-10.00</td>
<td>-10.00</td>
<td>-30.00</td>
<td>-30.00</td>
<td>1</td>
</tr>
<tr>
<td>B. On</td>
<td>22.00</td>
<td>50.00</td>
<td>-30.00</td>
<td>-30.00</td>
<td>-50.00</td>
<td>-50.00</td>
<td>1</td>
</tr>
<tr>
<td>C. Off</td>
<td>50.00</td>
<td>70.00</td>
<td>-30.00</td>
<td>-30.00</td>
<td>-50.00</td>
<td>-50.00</td>
<td>1</td>
</tr>
<tr>
<td>D. Off</td>
<td>70.00</td>
<td>90.00</td>
<td>-30.00</td>
<td>-30.00</td>
<td>-50.00</td>
<td>-50.00</td>
<td>1</td>
</tr>
<tr>
<td>E. Off</td>
<td>90.00</td>
<td>100.00</td>
<td>-30.00</td>
<td>-30.00</td>
<td>-50.00</td>
<td>-50.00</td>
<td>1</td>
</tr>
</tbody>
</table>

a. Res BW is set to 100 kHz, Fail Mask is set to Rel, and Abs Stop and Rel Stop are both set to Couple.

Offset
Selects the offset pairs (upper and lower) that the softkeys affect, and displays the memory selection menu from A to E (where you can store up to 5 sets of values for Start Freq, Stop Freq, Sweep Time, Res BW, Meas BW, Abs Start, Abs Stop, and so forth). Press Offset until the letter of the desired offset is underlined. Only one selection at a time is shown on this key label.

Key access: Meas > More > Spectrum Emission Mask > Offset/Limits

Start Freq On Off
Specifies the inner limit (frequency closest to the carrier) for both segments of the specified offset pair. When Start Freq (Off) is selected, the offset pair is not measured.

Key access: Meas > More > Spectrum Emission Mask > Offset/Limits

Stop Freq
Specifies the outer limit (frequency furthest from the carrier) for both segments of the specified offset pair. The minimum frequency difference between Start Freq and Stop Freq is limited to 100 Hz.

Key access: Meas > More > Spectrum Emission Mask > Offset/Limits

Sweep Time Auto Man
Specifies the sweep time for the currently selected offset, and toggles this function between Auto and Manual for each offset.

Key access: Meas > More > Spectrum Emission Mask > Offset/Limits
**Res BW**
Specifies the resolution bandwidth used in measuring the offset pair. When set to **Auto**, the Res BW from the default tables for “Offset/Limits” on page 114 are used. When set to **Man**, the allowed range is 1 kHz to 1MHz.

Key access: > More > Spectrum Emission Mask > Offset/Limits

**Abs Start**
Enables you to enter an absolute level limit at **Start Freq** for the currently selected offset ranging from –200.00 to +50.00 dBm with 4 significant digits.

Key access: > More > Spectrum Emission Mask > Offset/Limits > More

**Abs Stop**
Enters an absolute level limit at **Stop Freq** for the currently selected offset ranging from –200.00 to +50.00 dBm with 4 significant digits, and to toggle this function between **Couple** and **Man**. If set to **Couple**, this is coupled to **Abs Start** to make a flat limit line. If set to **Man, Abs Start** and **Abs Stop** you can enter different values to make a sloped limit line.

Key access: > More > Spectrum Emission Mask > Offset/Limits > More

**Rel Start**
Enter a relative level limit at **Start Freq** ranging from –150.00 to +50.00 dBc with 4 significant digits.

Key access: > More > Spectrum Emission Mask > Offset/Limits > More

**Rel Stop**
Enter a relative level limit at **Stop Freq** ranging from –150.00 to +50.00 dBc with 4 significant digits, and to toggle this function between **Couple** and **Man**. If set to **Couple**, this is coupled to **Rel Start** to make a flat limit line. If set to **Man, Rel Start** and **Rel Stop** you can enter different values to make a sloped limit line.

Key access: > More > Spectrum Emission Mask > Offset/Limits > More

**Fail Mask**
Displays the menu to select one of the following logic keys for fail conditions between the measurement results and the test limits: **Absolute, Relative, Abs AND Rel**, and **Abs OR Rel**.

Key access: > More > Spectrum Emission Mask > Offset/Limits > More > More
Absolute
Sets the limit test to show Fail if one offset is larger than the corresponding limit for Abs Start and/or Abs Stop. This is the default selection for each offset for BTS measurements.
Key access: > More > Spectrum Emission Mask > Offset/Limits > More > More > Fail Mask

Relative
Sets the limit test to show Fail if one offset's spectrum emission mask measurement results is larger than the corresponding limit for Rel Start and/or Rel Stop.
Key access: > More > Spectrum Emission Mask > Offset/Limits > More > More > Fail Mask

Abs AND Rel
Set the limit test to show Fail if one offset's spectrum emission mask measurement results is larger than both the corresponding limit for Abs Start and Abs Stop and the limit for Rel Start and Rel Stop.
Key access: > More > Spectrum Emission Mask > Offset/Limits > More > More > Fail Mask

Abs OR Rel
Set the limit test to show Fail if one offset’s the absolute spectrum emission mask measurement results is larger than the corresponding limit for Abs Start and Abs Stop or the limit for Rel Start and Rel Stop.
Key access: > More > Spectrum Emission Mask > Offset/Limits > More > More > Fail Mask

Meas BW
Specifies the bandwidth to use when measuring the offset. When using the front panel, only the currently selected offset is affected. All the offsets are affected when remote control. This is the multiplier applied to the resolution bandwidth to determine the bandwidth to integrate when calculating the power. Meas BW is now restricted to be 1 and not changeable.
Key access: > More > Spectrum Emission Mask > Offset/Limits > More > More
6 Instrument Messages

Overview  120
Command Errors  121
Execution Conflict  123
Device-Specific Errors  125
Overview

If an improper operation occurs during the instrument configuration, an message will appear on the status line indicating the incident and the how the spectrum analyzer corrected the setting automatically. You need to press  > More > Show errors to read the specific descriptions of those messages.

Example

In this example, an explanation is generally included with each error to further clarify its meaning. The instrument messages in this guide are listed numerically.

<Code>
-330  Self-test failed <Message>

A self-test failure occurred.

<Explanation in manual>
Command Errors

The messages listed below are command errors, which are saved into local registers.

-100 Command error
An unrecognized command or data type was encountered. This message is used when the device cannot detect more specifics described for errors -101 to -109.

-101 Invalid character
A syntactic element contains an invalid character.

-102 Syntax error
An unrecognized command or data type was encountered.

-103 Invalid separator
The parser was expecting a separator and encountered an illegal character.

-104 Data type error
The parser recognized a data element that is not allowed.

-108 Parameter not allowed
More parameters were received than expected for the header. For example, the *ESE common command only accepts one parameter, so receiving *ESE 0,1 is not allowed.

-109 Missing parameter
Fewer parameters were received than required for the header. For example, the *ESE common command requires one parameter, so receiving *ESE is not allowed.

-110 Command header error
An error was detected in the header. This message is used when the device cannot detect more specifics described for errors -111 to -119.
-112 Program mnemonic too long
The header contains more than 12 characters.

-113 Undefined header
The header is correct in syntax, but it is undefined for this device.

-128 Numeric data not allowed
A legal numeric data element was received, but the device does not accept one in this position for the header.

-130 Suffix error
This error is generated when parsing a suffix. This message is used when the device cannot detect more specifics described for errors -131 to -139.

-131 Invalid suffix
The suffix does not follow the syntax described in IEEE 488.2, or the suffix is inappropriate for the device.

-134 Suffix too long
The suffix contained more than 12 characters.

-138 Suffix not allowed
A suffix was encountered after a numeric element which does not allow suffixes.

-144 Character data too long
The character data element contains more than 12 characters.

-148 Character data not allowed
A legal character data element was encountered where prohibited by the device.
Execution Conflict

The system messages listed below are execution conflicts, indicating settings conflict during your operation.

-200 Execution Error
This is the generic syntax error for devices that cannot detect more specific errors.

-222 Data out of range
A legal program data element was parsed but could not be executed because the interpreted value was outside the legal range defined by the device. The displayed results may be clipped.

-223 Too much data not all points entered
Indicates that a legal program data element of block, expression, or string type was received that contained more data than the device could handle due to memory or related device-specific requirements.

-224 Illegal parameter value
An attempt was made to select a user file that contains 0 bits. Select another user file that contains at least 1 bit.

-241 Hardware missing
Missing device hardware. For example, the RF board is not installed.

-253 Corrupt media
A source media (possibly EEPROM) for a data file is corrupt. This error is usually seen in conjunction with errors concerning a certain file.

-300 Device-specific error
This is the device-specific error for devices that cannot detect more specific errors.
-330 Self-test failed
A self-test failure occurred. Report this error to Agilent Technologies.

-340 calibration failed
An expected file was not found while trying to load internal calibration.
Device-Specific Errors

102 Set 50 MHz signal < 0 dBm, do alignment again
   There is too much 50 MHz energy at the RF port for
   alignments to run. Reduce input power to less than 0 dBm
   and run alignments again.

104 1st LO Unlock
   The first LO on has lost phase lock. Report this error to the
   nearest Agilent Technologies sales or service office.

105 2nd LO Unlock
   The second LO has lost phase lock. Report this error to the
   nearest Agilent Technologies sales or service office.

201 Option not installed
   The desired operation cannot be performed because a
   required option is not installed.

204 TG Frequency Limit
   The tracking generator has reached the limit of its allowable
   frequency range.

211 RBW limited to 1 kHz when Span > 1 MHz
   In spans greater than 1 MHz, narrow (digital) resolution
   bandwidths, below 1 kHz, are not available.

213 Span limited to 1 MHz when RBW < 1 kHz
   In narrow (digital) resolution bandwidths, below 1 kHz,
   spans greater than 1 MHz are not available.

214 TG start freq is less than 9 kHz
   Tracking generator uncalibrated below 9 kHz.
6 Instrument Messages

215 TG start freq is less than 1/2 res bw
Tracking generator uncalibrated at start frequencies below 1/2 the current resolution bandwidth.

224 Option not licensed
The selected option requires a license. Refer to the installation procedures in the user guide provided for this particular option.

238 VBW filter or Average Detector cannot use both

501 RF over load
Either increase input attenuation or decrease the input signal level.

502 IF over load
Either increase input attenuation or decrease the input signal level.

604 File already exists
You attempted to save to a file that already exists. Either delete or rename the existing file or select a new name, then try again.

605 Media is protected
A save was attempted to a write-protected device.

610 File access is denied
The file is protected or hidden and cannot be accessed.

612 File not found
The analyzer could not find the specified file.

651 Connect TG OUT to RF IN
Attempt to align the tracking generator without its output connected. Connect the TG SOURCE to RF IN.
652 Connect CAL OUT to RF IN
you must connect the CAL OUT to RF IN with the appropriate cable.

751 Instrument state set to initial values
While trying to load a trace or state, the state information was found to be in error. This may be because the state had been stored on a later revision of analyzer firmware. A default set of state variables was loaded instead. There is nothing wrong with the analyzer.

752 Unable to load state from file
Attempt to load a state from a file failed.

753 Unable to save state to file
Attempt to save a state to a file failed. See the associated error messages for the cause.

757 Unable to load user state
A user preset failed, so the factory preset values were used. Save a valid state into user preset and try again.

758 Unable to save user state
Attempt to save a user preset state failed.

760 Unable to query state
Query of state over the remote interface was unsuccessful.

762 Unable to load file
A failure occurred while loading a file.

764 Unable to save file
Attempt to save a file failed; the file was not saved.
6 Instrument Messages

767 Fatal LDS error
Attempt to initialize the instrument state has failed. Cycle instrument power. If this fails to correct the problem, contact your nearest Agilent Technologies service center.

768 Unable to load user state
Attempt to load a state failed, because the state was saved with a measurement personality that is not currently loaded. Load the appropriate personality and try again.

770 Incorrect filename
You sent a remote command to save a screen file but did not specify a valid extension.

780 No Peak Found
No signal peak was found that meets the criteria under > Search Criteria.

781 Video Trigger cannot be active
You sent a remote command to do one of the following:
• Turn on video trigger while the Average Detector or a Marker Function is active.
• Turn on the Average Detector or a Marker Function while Video Trigger is active.

782 Video Trigger cannot be used with Mkr Func
Due to the Average Detector, the video Trigger cannot be used with Maker function.

783 Allowable span for current CF exceeded

784 Allowable CF for current span exceeded

805 Doing Alignment
7

In Case of Difficulty

Check the Basics  130
Read the Warranty  131
Contact Agilent Technologies  132

This chapter includes information on how to check for a problem with your spectrum analyzer, and how to contact Agilent Technologies for service.
Check the Basics

Before calling Agilent Technologies, or returning an analyzer for service, perform the quick checks listed below. This check may eliminate the problem.

- Is there power at the receptacle?
- Is the analyzer turned on? Listen for internal fan noise to determine if the analyzer cooling fan is running. Feel the rear side of the analyzer for air flow.
- If other equipment, cables, and connectors are being used with your spectrum analyzer, make sure they are connected properly and operating correctly.
- Review the measurement procedures being performed when the problem first appeared. Make sure all of the settings are correct.
- If the analyzer is not functioning as expected, return the analyzer to a known state by pressing > Preset. For details, refer to “Presetting the Spectrum Analyzer” on page 25.
- Is the measurement being performed, and the results that are expected, within the specifications and capabilities of the analyzer? Refer to the Technical Overview for your analyzer.
- Is the analyzer displaying an error message? If so, refer to “Instrument Messages” on page 119.
- To meet specifications, the analyzer must be aligned. For more information on how to align the analyzer, please refer to “Running Internal Alignments” on page 20.

WARNING There are no service components in the spectrum analyzer. To prevent electrical shock, please don’t disassemble your spectrum analyzer. Please contact Agilent Technologies or professional service provider for your service.
Read the Warranty

Agilent Technologies provide one year warranty as standard for your spectrum analyzer. The warranty information for your spectrum analyzer is in the back of *Technical Overview*. Please read it and be familiar with its terms.

If your spectrum analyzer is covered by a separate maintenance agreement, please be familiar with its terms.

Agilent Technologies offers several optional maintenance plans to service your spectrum analyzer after its warranty has expired. Call the nearest Agilent Technologies sales office for full details.

If you want to service the spectrum analyzer yourself after the warranty expires, you can purchase the *Service Guide* that provides all necessary test and maintenance information.
Contact Agilent Technologies

Agilent Technologies has offices around the world to provide you with complete support for your source. To obtain servicing information or to order replacement parts, contact the Agilent Technologies customer contact center listed below. In any correspondence or telephone conversations, refer to your spectrum analyzer by its product number and full serial number, press > More > Show System.

Online help:  http://www.agilent.com/find/assist

United State  Canada  Europe
(tel) 800 829 4444  (tel) 877 894 4414  (tel) +31 20 547 2111
(fax) 800 829 4433  (fax) 800 746 4866

Korea  Japan  Latin America
(tel) 080 769 0800  (tel) +81 426 56 7832  (tel) +1 (305) 269 7500
(fax) 080 769 0900  (fax) +81 426 56 7840

China  Taiwan  Australia
(tel) 800 810 0189  (tel) 0800 047 866  (tel) 1 800 629 485
(fax) 800 820 2816  (fax) 0800 286 331  (fax) +61 (3) 9210 5947

Other Asia Pacific Countries
(tel) +65 6375 8100
(fax) +65 6755 0042

E-mail: tm_ap@agilent.com
This chapter provides a visual representation of the front panel keys and their associated menu keys (in Spectrum Analyzer mode). Refer to Chapter 4, “Key Reference” for key function descriptions.

The name editor menu is shown separately, though it is accessed when entering data for many keys. The front-panel key menus appear in alphabetical order as follows.
Amplitude Menu

Amplitude

- Ref Level
- Attenuation
  - Auto Man
- Scale/Div
- Scale Type
  - Log Lin
- Int Preamp
  - On Off
- More
  - 1 of 2

Y Axis Units >
- More
  - 2 of 2

- dBm
- dBmV
- dBuV
- dBuA
- Watts
- Volts
- Amps
BW/Avg Menu

- Res BW
  - Auto
  - Man
- Video BW
  - Auto
  - Man
- VBW/RBW
  - Auto
  - Man
- Average
  - On
  - Off
- Avg Type
  - >
  - Auto
  - Man
Det/Display Menu

<table>
<thead>
<tr>
<th>Det/Display Menu</th>
<th>Det/Display Menu</th>
<th>Det/Display Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detector &gt; Auto Man</td>
<td>Top Auto Man</td>
<td>Return</td>
</tr>
<tr>
<td>Active Fctn Position &gt;</td>
<td>Center Auto Man</td>
<td>Delete All Limits</td>
</tr>
<tr>
<td>Display Line On Off</td>
<td>Bottom Auto Man</td>
<td>Delete Limit</td>
</tr>
<tr>
<td>Limits &gt;</td>
<td>Return Auto Man</td>
<td>Return</td>
</tr>
<tr>
<td>Limit 1 &gt;</td>
<td>Type Auto Man</td>
<td>Return</td>
</tr>
<tr>
<td>Limit 2 &gt;</td>
<td>Upper Auto Man</td>
<td>Frequency</td>
</tr>
<tr>
<td></td>
<td>Limit Lower Auto Man</td>
<td>Amplitude</td>
</tr>
<tr>
<td></td>
<td>On Off Auto Man</td>
<td>Connected Yes No</td>
</tr>
<tr>
<td></td>
<td>Test On Off Auto Man</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Margin On Off Auto Man</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Edit &gt; Automan</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete Point Automan</td>
<td></td>
</tr>
<tr>
<td>Delete All Limits</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Return</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
File Menu (1 of 2)
a. The path depends on the **Load > Type** selection.
Frequency Menu

- Center Freq
- Start Freq
- Stop Freq
- CF Step
- Auto Man
- Signal Track
- On Off
Marker Menu

Select Marker > 1,2,3...12
   Normal
   Delta >
       Off
       All Off
   Function >
       More 1 of 2

Select Marker > 1
   Marker Trace
       Auto 1 2 3 4
   Marker Table >
       More 2 of 2

Freq Counter >
   On
   Off
   Prev Page
   Next Page

Phase Noise >
   Opti Φ Noise
       On Off

Opti Φ Noise
       On Off

Span Pair
   Ref Delta

Freq Counter >
   Resolution
       Auto Man

Resolution
       Auto Man

Phase Noise
   On Off

Phase Noise
   On Off

Offset
   -30kHz 30kHz
   -50kHz 50kHz
   -100kHz 100kHz
   -1MHz 1MHz

Offset
   -30kHz 30kHz
   -50kHz 50kHz
   -100kHz 100kHz
   -1MHz 1MHz

Return

Delta >
   Off
   All Off

Return

More 1 Of 2

Return
Marker-> Menu

Marker ->

Mkr-> CF
Mkr-> CF Step
Mkr-> Start
Mkr-> Stop
Mkr-> Ref Lvl

Menu Maps 8

N9320A Spectrum Analyzer 141
Measure Menu (1 of 2)

Meas

Measure Off
Channel Power
Occupied BW >
ACP >

More

1 of 2

Avg Number
On Off
Avg Mode
Exp Repeat
Max Hold
On Off
Occ BW% Pwr
OBW Span

More
Return

Avg Number
On Off
Avg Mode
Exp Repeat
Integ BW
Chan Pwr Span

More
Return

Avg Number
On Off
Avg Mode
Exp Repeat
Off Set ABCDEF
Offset Freq
On Off
Ref BW
Pos Offset Limits
Neg offset Limits

Method
IBW RBW
Total Pwr/PSD
Auto Man
Limits
On Off

More
Return

Intermod >
(TOI)

Spectrum
Emission Mask

More

2 of 2

a. Continued on sheet 2 of 2
Measure Menu (2 of 2)

a. Links to Meas Menu (sheet 1 of 2)
MODE Menu

- Spectrum Analyzer
- Tracking Generator
Name editor Menu

Name

ABCDEF
HIJKLMN
OPQRSTU
VWXYZ
Return
Peak Search Menu

- Peak Search
  - Next Peak
  - Next Pk Right
  - Next Pk Left
  - Min Search
  - Pk-Pk Search
  - More
    1 of 2

- Peak Excursion
  - Peak Threshold
    - Threshold Hidden
    - Peak Search Type
  - Return

- Continuous Pk
  - On Off
- N dB Points
  - On Off
- Search Criteria
  - Peak Table
    - More
      2 of 2

- Max Value
  - Excursion & Threshold
  - Return
Preset/System Menu

Preset
Pwr on/Preset
Alignment>
Language>
Diagnostics>
More 1 of 3

Show System
Show Hardware
Show Software
Show Errors>
Time/Date>
More 2 of 3

Licensing>
Option
License Key
Activate License
Brightness
Service
More 3 of 3

Align (Ext Cable)
Return
CAL OUT
On
Off

Power On
Last Preset
Preset Type>
Save User
Preset

English
User
Factory

Front Panel Test

MDY
DMY

Prev Page
Next Page
Clear error
Queue
SPAN Menu

- Span
- Full Span
- Zero Span
- Last Span
Sweep/Trig Menu

Sweep Time
  Auto
  Man

Sweep Single

Sweep Cont

More
  1 of 2

Free Run

Video

External Pos

External Neg

More
  2 of 2
View/Trace Menu

View/Trace

Select Trace > 1
Clear Write
Max Hold
Min Hold
View
Blank

Trace 1
Trace 2
Trace 3
Trace 4
Index

Numerics
10 MHz REF OUT, 8
3GPP W-CDMA, 114
802.11a, 115
802.11b, 116

A
Abs Start, 117
Abs Stop, 117
AC power receptacle, 8
Active Fctn Position, 67
active function, 6
adjacent channel power, 107
Agilent Technologies, contact, 132
Alignment, 93
running, 20
Amplitude key, 3, 58
annotation, marker, 26
annotations, display, 6
Attenuation, 58
attenuation, reducing, 37
Auto Tune key, 4, 60
Average, 63

B
Back, 61
BW/Avg key, 4, 62

C
CAL OUT connector, 5
Catalog, 72
CE mark, 9
Center Freq, 78
CF Step, 78
channel power, 102
comparing signals
off screen, 30
on the screen, 28
connector
CAL OUT, 5
EXT TRG IN, 8
PROBE POWER, 5
REF IN, 8
REF OUT, 8
RF IN, 5
TG SOURCE, 5
USB, 5, 8
VGA, 8
Continuous PK, 88
Copy, 76
CSA mark, 9
c-tick mark, 9

D
Data control keys, 4
Delete, 75
delta marker, 80
Det/Display key, 4, 65
detector, 65
Display, 6
Display Line, 67, 68
distortion, measuring, 45

E
Enter key, 71
error message, 19
ESD, 16
EXT TRG IN(TTL), 8
external reference, 20, 21

F
factory preset state, 92
Fail Mask, 117
File key, 72
File/Print key, 4
firmware revision, update, 21
frequency counter, 82
Frequency key, 3
front panel
display annotations, 6
overview, 3
symbols, 9
front panel, using, 24

H
harmonic distortion
measuring, 45

I
improving frequency resolution and
accuracy, 41
instruction manual, 9
instrument messages, 119
Int Preamp, 59
IO libraries suite, 22
ISM1-A, 9

L
LAN, 8
Licensing, 96
Limits, 68
Load, 74
Local, 4
lock, 8
Index

M
Marker key, 4, 80
Marker Table, 83
Marker-> key, 4, 84
Max Mixer lvl, 111
Meas key, 4, 85, 101
measuring
ACP, 107
channel power, 102
disortion, 45
distortion, 45
low-level signal, 37
multiple signals, 28
occupied BW, 104
SEM, 112
source’s frequency drift, 43
TOI, 48, 110
measuring phase noise, 51
menu maps, 133
messages, 19
Min Search, 87
MODE key, 4, 86

N
N dB Points, 88
Next Peak, 87

O
occupied BW, 104
Offset/Limits, 108, 114
options, 12
  enable, 20
  licensing, 96
  TG3, 5
order list, 12

P
Peak Search key, 4, 87
Peak Table, 90
Phase Noise, 82
phase noise, measuring, 51
power cord, 13
power receptacle, 8
power requirements, 13
power switch, 8
Preset, 91
preset
  factory, 25
  user, 25
Preset/System key, 4, 91
PROBE POWER, 5
Pwr on/Preset, 93

R
rear panel overview, 8
REF IN, 8
Ref level, 58
REF OUT, 8
Rel Start, 117
Rel Stop, 117
remote control, 22
requirements
  ventilation, 17
Res BW, 62
resolving signals
  equal amplitude, 32
  hidden by large signals, 35
RF IN connector, 5

S
Save, 73
Scale/Div, 58
Search Criteria, 88
Show System, 94
Signal Track, 79
softkeys, 3
SPAN key, 3, 97
spectrum emission mask, 112
standby switch, 5
Start Freq, 78
Stop Freq, 78
Sweep/Trig key, 4, 98

T
TG SOURCE connector, 5
Threshold Hidden, 89
TOI
  Meas key, 110
  measuring, 48
  TOI Span, 111
  tracking drifting signals, 43

U
USB
  DEV, 8
  host, 8
  using frequency counter, 41

V
VBW/RBW, 62
ventilation, 17
VGA, 8
Video BW, 62
View/Trace key, 4, 100
viewing signal, 25

W
WEEE, 9
DECLARATION OF CONFORMITY

According to ISO/IEC Guide 22 and CEN/CENELEC EN 45014

Manufacturer's Name: Agilent-Qianfeng Electronic Technologies (Chengdu) Co., Ltd

Manufacturer's Address: Qianfeng Hi-Tech Industry Park,
Chengdu Hi-Tech Industrial Development Zone (West District),
Chengdu, 611731 P.R.C.

Declarations under sole responsibility that the product as originally delivered

Product Name: Spectrum Analyzer
Model Number: N9320A
Product Options: This declaration covers all options of the above product(s)

This product complies with the essential requirements of the following applicable European Directives, and carries the CE marking accordingly:


and conforms with the following product standards:

- **EMC**
  - IEC 61000-4-3:1995 / EN 61000-4-3:1995
  - IEC 61000-4-4:1995 / EN 61000-4-4:1995
  - IEC 61000-4-6:1996 / EN 61000-4-6:1996
  - Canada: ICES-001:1998
  - Australia/New Zealand: AS/NZS 2064.1

  **Limit**: Class A Group 1
  - 4 kV CD, 8 kV AD
  - 3 V/m, 80-1000 MHz
  - 0.5 kV signal lines, 1 kV power lines
  - 0.5 kV line-line, 1 kV line-ground
  - 3 V, 0.15-80 MHz
  - 1 cycle/ 100%

  This product was tested in a typical configuration with Agilent Technologies test systems.

- **Safety**
  - Canada: CSA C22.2 No. 61010-1:2004
  - USA: UL 61010-1: 2004

  **Supplementary Information:**
  This DoC applies to above-listed products placed on the EU market after:

  Nov 16, 2006

  Date

  Shi Wen
  Quality Manager

For further information, please contact your local Agilent Technologies sales office, agent or distributor, or Agilent Technologies Deutschland GmbH, Herrenberger Straße 130, D 71034 Böblingen, Germany.